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Δπραξηζηίεο 

 
Θα ζέιακε απφ θνηλνχ λα επραξηζηήζνπκε ηηο νηθνγέλεηέο καο πνπ καο βνήζεζαλ ζηηο ζπνπδέο 

καο θαη ηνλ θ. Παπαδάθε πνπ καο βνήζεζε κε ηελ πηπρηαθή καο εξγαζία. 
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Κεθάιαην 1: Δηζαγσγή 

1.1 Πεξίιεςε 

 
θνπφο ηεο πηπρηαθήο απηήο είλαη ε κειέηε, ε ζρεδίαζε θαη ε πινπνίεζε κίαο δηαδηθηπαθήο 

εθαξκνγήο ελφο ειεθηξνληθνχ θαηαζηήκαηνο εκπνξίνπ ,κε ζπζζσξεπηέο παληφο είδνπο, ηχπνπ e-

shop. ηελ εθαξκνγή απηή ππάξρεη κία βάζε δεδνκέλσλ κε δίαθνξεο πιεξνθνξίεο γηα ην 

θαηάζηεκα ηελ νπνία δηαρεηξηδφκαζηε κε ην πξφγξακκα mysql . Γηα ηελ εθηέιεζε ηεο εθαξκνγήο 

ρξεζηκνπνηήζεθε έλαο web server, ν νπνίνο καο δίλεη ηελ δπλαηφηεηα λα ππάξρεη ε εθαξκνγή 

ζην δηαδίθηπν,  ν apache web server. Δπηπιένλ ρξεζηκνπνηήζεθε θψδηθαο php θαη javascript, ελψ 

γηα ην γξαθηζηηθφ πεξηβάιινλ ρξεζηκνπνηήζεθε ε εθαξκνγή adobe photoshop. 

Η εθαξκνγή απηή παξέρεη πνιιέο επηινγέο ζηνλ δηαρεηξηζηή ηνπ ειεθηξνληθνχ θαηαζηήκαηνο 

φπσο ε δηακφξθσζε ραξαθηεξηζηηθψλ ησλ πξντφλησλ θαη ησλ ππεξεζηψλ πνπ παξέρνληαη απφ 

θαηάζηεκα, ε θαηαρψξεζε θαη δηαρείξεζε εγγεγξακκέλσλ πειαηψλ θ.α.  

1.2 Κίλεηξν 

 

Κίλεηξν γηα ηελ πινπνίεζε ηεο πηπρηαθήο απηήο εξγαζίαο απνηέιεζε ε αλάπηπμε θαη ε 

απνηειεζκαηηθφηεηα ηνπ ειεθηξνληθνχ εκπνξίνπ ηφζν ζηελ Διιάδα φζν θαη ηνλ ππφινηπν 

θφζκν –βάζεη θαη κειεηψλ πνπ ζα δνχκε παξαθάησ -. Η κειέηε, εθκάζεζε θαη θαηαλφεζε πνπ 

νδεγεί ζηελ πινπνίεζε κηαο ηέηνηαο εθαξκνγήο απνηειεί αμηφινγν πιενλέθηεκα ζηελ αγνξά 

εξγαζίαο 

1.3 θνπόο θαη ζηόρνο 

 

θνπφο ηεο εξγαζίαο απηήο είλαη ε θαηαζθεπή ελφο ειεθηξνληθνχ θαηαζηήκαηνο ηχπνπ e-shop κε 

ηελ ρξήζε δίαθνξσλ πξνγξακκάησλ ηφζν ζε πξνγξακκαηηζηηθφ ηνκέα φζν θαη ζε γξαθηζηηθφ. 

ηφρνο ηεο εξγαζίαο είλαη πέξα απφ ηα εκπνξηθά νθέιε κίαο ηέηνηαο εθαξκνγήο, ε εμνηθείσζε κε 

ηελ πινπνίεζε παξφκνησλ θαηαζηεκάησλ θαζψο θαη κε ηελ δηαρείξεζή ηνπο. 

1.4 Γνκή εξγαζίαο 

  

Η δνκή ηεο εξγαζίαο έρεη σο εμήο: 

 Δηζαγσγηθά ζεκεηψκαηα γηα ηελ εμήγεζε ηεο εθαξκνγήο θαζψο θαη γηα ηνλ ζθνπφ θαη 

ηνλ ζηφρν ηεο 

 Θεσξεηηθέο πιεξνθνξίεο  ζρεηηθά κε έλλνηεο πνπ πξαγκαηεχνληαη ζηελ εξγαζία 

 Ιζηνξηθά ζηνηρεία θαζψο θαη έξεπλεο γηα ην ειεθηξνληθφ εκπφξην  
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 πλνπηηθή πεξηγξαθή εθαξκνγψλ θαη γισζζψλ πξνγξακκαηηζκνχ πνπ 

ρξεζηκνπνηήζεθαλ γηα ηελ πινπνίζεζε ηεο πηπρηαθήο εξγαζίαο 

 Δηδηθφηεξε αλάιπζε ηεο ιεηηνπξγίαο ηεο  πιαηθφξκαο opencart πνπ ρξεζηκνπνηήζεθε 

πεξηζζφηεξν, κε ηελ επηζχλαςε εηθφλσλ απφ ηελ ιεηηνπξγία (screenshots) 

 Δπίινγνο κε ζπκπεξάζκαηα θαη εληππψζεηο κεηά ην πέξαο ηεο πινπίεζεο  

Κεθάιαην 2: Μεζνδνινγία 

 

2.1 Μέζνδνο αλάιπζεο θαη αλάπηπμεο 

2.2 Θεσξίεο 

2.2.1 Γηαδίθηπν (Internet)  

 

 

1 internet 

Σν Γηαδίθηπν (αγγι. Internet) είλαη παγθφζκην ζχζηεκα δηαζπλδεδεκέλσλ δηθηχσλ ππνινγηζηψλ, 

νη νπνίνη ρξεζηκνπνηνχλ θαζηεξσκέλε νκάδα πξσηνθφιισλ, ε νπνία ζπρλά απνθαιείηαη 

"TCP/IP" (αλ θαη απηή δελ ρξεζηκνπνηείηαη απφ φιεο ηηο ππεξεζίεο ηνπ Γηαδηθηχνπ) γηα λα 

εμππεξεηεί εθαηνκκχξηα ρξεζηψλ θαζεκεξηλά ζε νιφθιεξν ηνλ θφζκν. Οη δηαζπλδεδεκέλνη 

ειεθηξνληθνί ππνινγηζηέο αλά ηνλ θφζκν, νη νπνίνη βξίζθνληαη ζε έλα θνηλφ δίθηπν 

επηθνηλσλίαο, αληαιιάζζνπλ κελχκαηα (παθέηα) κε ηε ρξήζε δηαθφξσλ πξσηνθφιισλ 

(ηππνπνηεκέλνη θαλφλεο επηθνηλσλίαο), ηα νπνία πινπνηνχληαη ζε επίπεδν πιηθνχ θαη ινγηζκηθνχ. 

Σν θνηλφ απηφ δίθηπν θαιείηαη Γηαδίθηπν. 

http://el.wikipedia.org/wiki/%CE%94%CE%B9%CE%B1%CE%B4%CE%AF%CE%BA%CF%

84%CF%85%CE%BF 

http://el.wikipedia.org/wiki/%CE%97%CE%BB%CE%B5%CE%BA%CF%84%CF%81%CE%BF%CE%BD%CE%B9%CE%BA%CF%8C%CF%82_%CF%85%CF%80%CE%BF%CE%BB%CE%BF%CE%B3%CE%B9%CF%83%CF%84%CE%AE%CF%82
http://el.wikipedia.org/wiki/%CE%A5%CE%BB%CE%B9%CE%BA%CF%8C
http://el.wikipedia.org/wiki/%CE%9B%CE%BF%CE%B3%CE%B9%CF%83%CE%BC%CE%B9%CE%BA%CF%8C
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2.2.2 www 

 

 

2 world wide web 

Παγθφζκηνο ηζηφο είλαη ην δίθηπν ησλ ζπλδεδεκέλσλ ππνινγηζηψλ θαη δηθηχσλ ζε παγθφζκηα 

θιίκαθα, ην νπνίν ρξεζηκνπνηεί ζπγθεθξηκέλε νκάδα πξσηνθφιισλ επηθνηλσλίαο, γλσζηή σο 

"http". Κάζε δίθηπν-δνκηθή κνλάδα ηνπ δηαδηθηχνπ απνηειείηαη απφ ζπλδεδεκέλνπο ππνινγηζηέο 

ζε ηνπηθφ επίπεδν, γηα παξάδεηγκα ην δίθηπν ππνινγηζηψλ ησλ θεληξηθψλ γξαθείσλ κηαο 

εηαηξίαο. Απηά ηα δίθηπα κε ηε ζεηξά ηνπο ζπλδένληαη ζε επξχηεξα δίθηπα, φπσο εζληθά θαη 

ππεξεζληθά. Σν επξχηεξν δίθηπν ζηνλ θφζκν ιέγεηαη παγθφζκηνο ηζηφο ην νπνίν είλαη κνλαδηθφ 

(δειαδή δελ ππάξρνπλ παξαπάλσ απφ έλα δίθηπα ππνινγηζηψλ παγθφζκηαο θιίκαθαο), θαη 

ζπκπεξηιακβάλεηαη ηφζν ηα γήηλα δίθηπα, φζν θαη ηα δίθηπα ησλ δνξπθφξσλ ηεο θαη άιισλ 

δηαζηεκηθψλ ζπζθεπψλ πνπ είλαη ζπλδεδεκέλα ζε απηφ. 

Η ηερλνινγία ηνπ ηζηνχ θαζηζηά δπλαηή ηελ δεκηνπξγία "ππεξθεηκέλσλ", κία δηαζχλδεζε δειαδή 

πάξα πνιιψλ κε ηεξαξρεκέλσλ ζηνηρείσλ πνπ παιαηφηεξα ήηαλ απνκνλσκέλα. Σα ζηνηρεία απηά 

κπνξνχλ λα πάξνπλ θαη άιιεο κνξθέο πέξαλ ηεο κνξθήο ηνπ γξαπηνχ θεηκέλνπ, φπσο εηθφλαο θαη 

ήρνπ. 

Η ηερλνινγία ηνπ ηζηνχ δεκηνπξγήζεθε ην 1989 απφ ηνλ Βξεηαλφ Σηκ Μπέξλεξο Λε, πνπ εθείλε 

ηελ επνρή εξγαδφηαλ ζηνλ Δπξσπατθφ Οξγαληζκφ Ππξεληθψλ Δξεπλψλ (CERN) ζηελ Γελεχε ηεο 

Διβεηίαο. Σν φλνκα πνπ έδσζε ζηελ εθεχξεζή ηνπ ν ίδηνο ν Lee είλαη World Wide Web, φξνο 

γλσζηφο ζηνπο πεξηζζφηεξνπο απφ ην "www". Απηφ πνπ νδήγεζε ηνλ Lee ζηελ εθεχξεζε ηνπ 

Παγθφζκηνπ ηζηνχ ήηαλ ην φξακά ηνπ γηα έλα θφζκν φπνπ ν θαζέλαο ζα κπνξνχζε λα 

αληαιιάζζεη πιεξνθνξίεο θαη ηδέεο άκεζα πξνζβάζηκεο απφ ηνπο ππνινίπνπο. Σν ζεκείν ζην 

νπνίν έδσζε ηδηαίηεξν βάξνο ήηαλ ε κε ηεξάξρεζε ησλ δηαζπλδεδεκέλσλ ζηνηρείσλ. 

Οξακαηίζηεθε θάζε ζηνηρείν, θάζε θφκβν ηνπ ηζηνχ ίζν σο πξνο ηελ πξνζβαζηκφηεηα κε ηα 

ππφινηπα. Αλ ζθεθηεί, φκσο, θαλείο ηνλ βαζκφ ηεξάξρεζεο κε ηνλ νπνίν ιεηηνπξγνχλ νη κεραλέο 

αλαδήηεζεο ηνπ ηζηνχ, φπσο γηα παξάδεηγκα ην google, γίλεηαη εχθνια θαηαλνεηφ φηη ζηελ 

πξάμε θάηη ηέηνην δελ ζπκβαίλεη, ηνπιάρηζηνλ ζηνλ βαζκφ πνπ ην είρε νξακαηηζηεί ν Lee. 

http://el.wikipedia.org/wiki/%CE%A0%CE%B1%CE%B3%CE%BA%CF%8C%CF%83%CE%

BC%CE%B9%CE%BF%CF%82_%CE%99%CF%83%CF%84%CF%8C%CF%82 

http://el.wikipedia.org/wiki/%CE%94%CE%AF%CE%BA%CF%84%CF%85%CE%BF_%CF%85%CF%80%CE%BF%CE%BB%CE%BF%CE%B3%CE%B9%CF%83%CF%84%CF%8E%CE%BD
http://el.wikipedia.org/wiki/%CE%A4%CE%B9%CE%BC_%CE%9C%CF%80%CE%AD%CF%81%CE%BD%CE%B5%CF%81%CF%82_%CE%9B%CE%B7
http://el.wikipedia.org/wiki/CERN
http://el.wikipedia.org/wiki/World_Wide_Web
http://el.wikipedia.org/wiki/Google
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2.2.3 Δίδε ηζηνζειίδσλ 

 

ηαηηθέο Ιζηνζειίδεο 

Η ζηαηηθή ηζηνζειίδα είλαη κηα απιή κνξθή ηζηνζειίδαο πνπ παξνπζηάδεη πεξηερφκελν ζηνπο 

επηζθέπηεο ηεο ζειίδαο ρσξίο λα πξνζθέξεη δηαδξαζηηθφηεηα ζην ρξήζηε. Μπνξεί λα είλαη 

παξνπζίαζε ηεο εηαηξείαο ζαο κε θάπνην θείκελν, πνιπκεζηθφ πιηθφ (εηθφλεο, video, ήρν) αιιά 

είλαη έλα πεξηερφκελν πνπ δελ κεηαβάιιεηαη εχθνια θαη δελ έρεη αιιειεπίδξαζε κε ην ρξήζηε 

εθηφο αλ εμαηξέζνπκε ηελ απνζηνιή θάπνηνπ κελχκαηνο ζε εζάο κέζσ ηεο ζπκπιήξσζεο κηαο 

θφξκαο. Γηα λα θαηαιάβεηε ηε ζεκαζία ηεο δηαδξαζηηθφηεηαο ηνπ ρξήζηε ζαο παξεζέηνπκε ην 

παξάδεηγκα φπνπ έρεηε κηα ζειίδα πνπ παξνπζηάδεη ηα πξντφληα ζαο, κε εηθφλεο, ηηκέο θ.η.ι. 

αιιά φπνπ ν ρξήζηεο δε κπνξεί λα αγνξάζεη ην πξντφλ απφ ηνλ ηζηνρψξν ζαο. Δίλαη ηδαληθέο γηα 

ηελ πξνβνιή ησλ ππεξεζηψλ ζαο γηαηί είλαη μεθάζαξεο θαη κε κηθξφ θφζηνο ζε ζρέζε κε ηηο 

δπλακηθέο, είλαη γξήγνξεο γηαηί είλαη ειαθξηέο, δελ απαηηείηαη ζπρλή ελεκέξσζε αθνχ ν φγθνο 

ηνπ πιηθνχ είλαη ζπγθεθξηκέλνο αιιά δελ παξέξρνπλ δπλακηθή δηαρείξηζε ηνπ ηδηνθηήηε (ζε 

πεξίπησζε αιιαγψλ ρξεηάδεηαη θάπνην support ζπλήζσο). 

 

Γπλακηθέο Ιζηνζειίδεο 

Οη δπλακηθέο ζειίδεο θαηαξρήλ παξέρνπλ δπλακηθή δηαρείξηζε ζην δηαρεηξηζηή ηνπ ηζηνρψξνπ 

πνπ ζεκαίλεη φηη ην πεξηερφκελν ηεο ζειίδαο κπνξεί λα αιιάδεη ηαθηηθά. Δπηπιένλ ν επηζθέπηεο 

ηεο ζειίδαο κπνξεί λα έρεη θάπνηα αιιειεπίδξαζε κε ην website φπσο λα θάλεη αγνξέο, λα 

γξάθεη posts, λα θάλεη downloads απφ ηε ζειίδα θ.η.ι. Οη ζειίδεο απηέο ζε θάπνην βαζκφ είλαη 

έηζη ζρεδηαζκέλεο ψζηε ην πεξηερφκελν λα αιιάδεη εχθνια απφ εζάο ρσξίο ηελ απαίηεζε 

θάπνηνπ support. Δίλαη ηζηνζειίδεο πνπ κπνξείηε λα παξνπζηάδεηε ηηο εηδήζεηο ηεο εηαηξείαο ζαο, 

ηα λέα πξντφληα ζαο, λα γίλνληαη ζπλαιιαγέο, ζρφιηα απφ ηνπο επηζθέπηεο, θαη γεληθψο ε κνξθή 

θαη ην πεξηερφκελν ηνπ website λα είλαη δπλακηθφ. 

2.2.4 Ηιεθηξνληθό εκπόξην (e-commerce) 

 
3 e-commerce 

Ειςαγωγή 

ην πξφζθαην παξειζφλ νη ζπλαιιαγέο θαη νη αγνξέο ησλ θαηαλαισηψλ θαη 
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αληίζηνηρα ν πσιήζεηο ησλ εκπφξσλ γίλνληαλ κε θαζαξά ζπκβαηηθά κέζα. Οη 

θαηαλαισηέο πξνθεηκέλνπ λα αγνξάζνπλ απηφ πνπ επηζπκνχζαλ ή λα δερηνχλ κία 

ππεξεζία έπξεπε λα κεηαβνχλ ζηελ έδξα ηνπ πξνκεζεπηή ησλ αγαζψλ ή ησλ 

ππεξεζηψλ. ηηο κέξεο καο ν ηξφπνο δηεμαγσγήο ησλ ζπλαιιαγψλ έρεη αιιάμεη 

ξηδηθά.  

 

 Έλαο απφ ηνπο λένπο θαη ηάρηζηνπο ηξφπνπο εμππεξέηεζεο ησλ θαηαλαισηψλ 

είλαη ην Ηιεθηξνληθφ Δκπφξην ην νπνίν αλαπηχζζεηαη ξαγδαία ζην εμσηεξηθφ αιιά 

θαη ζηελ Διιάδα κε πην αξγνχο φκσο ξπζκνχο.  

 

 Δλδεηθηηθφ ηεο θαζπζηεξεκέλεο αλάπηπμεο ηνπ ειεθηξνληθνχ εκπνξίνπ ζηελ 

Διιάδα είλαη νη δχν ππνπξγηθέο απνθάζεηο 3035/Β2-48.2001 θαη 7681/Β2-255.2001  

πνπ πξνσζνχλ ηε δηελέξγεηα δνθηκαζηηθήο έξεπλαο γηα ην ειεθηξνληθφ εκπφξην. Οη 

απνθάζεηο απηέο είλαη ηνπ 2001, ρξνληά πνπ ζε άιιεο επξσπατθέο ρψξεο αλζνχζε ην 

ειεθηξνληθφ εκπφξην. Αιιά θαη νη ππνπξγηθέο απνθάζεηο 4708/2003 36/2003 θαη 

10220/Γ3-573/2004 πνπ θαηαδεηθλχνπλ ην ίδην πξάγκα. 

 

Ση είλαη ην "ειεθηξνληθό εκπόξην"; 

   

Πξφθεηηαη γηα θάζε είδνο εκπνξηθήο ζπλαιιαγήο κεηαμχ πξνζψπσλ (θπζηθψλ θαη 

κε) πνπ πξαγκαηνπνηείηαη κε ειεθηξνληθά κέζα. Δίλαη ε δηάζεζε θαη αγνξαπσιεζία 

πξντφλησλ ειεθηξνληθά, ε δηεθπεξαίσζε εκπνξηθψλ ιεηηνπξγηψλ θαη ζπλαιιαγψλ 

ρσξίο ηε ρξήζε ραξηηνχ, ζπλήζσο κέζσ δηθηχσλ ειεθηξνληθψλ ππνινγηζηψλ.  

Πξφθεηηαη γηα ηελ αγνξαπσιεζία αγαζψλ, πιεξνθνξηψλ θαη ππεξεζηψλ κέζα απφ 

δίθηπα ειεθηξνληθψλ ππνινγηζηψλ 

Σν ειεθηξνληθφ εκπφξην κπνξεί λα νξηζηεί απφ ηέζζεξηο δηαθνξεηηθέο νπηηθέο 

γσλίεο: 

• Δπηρεηξήζεηο: Ωο εθαξκνγή λέσλ ηερλνινγηψλ πξνο ηελ θαηεχζπλζε ηνπ 

απηνκαηηζκνχ ησλ ζπλαιιαγψλ θαη ηεο ξνήο εξγαζηψλ.  

• Τπεξεζίεο: Ωο κεραληζκφο πνπ έρεη ζηφρν λα ηθαλνπνηήζεη ηελ θνηλή 

επηζπκία πξνκεζεπηψλ θαη πειαηψλ γηα θαιχηεξε πνηφηεηα ππεξεζηψλ,  

κεγαιχηεξε ηαρχηεηα εθηέιεζεο ζπλαιιαγψλ θαη κηθξφηεξν θφζηνο.  

• Απφζηαζε: Ωο δπλαηφηεηα αγνξαπσιεζίαο πξντφλησλ θαη ππεξεζηψλ κέζσ 

ηνπ Internet αλεμάξηεηα απφ ηε γεσγξαθηθή απφζηαζε.  

• Δπηθνηλσλία: Ωο δπλαηφηεηα παξνρήο πιεξνθνξηψλ, πξντφλησλ ή 

ππεξεζηψλ, θαη πιεξσκψλ κέζα απφ δίθηπα ειεθηξνληθψλ ππνινγηζηψλ. 

 

Αλάπηπμεο ηνπ ειεθηξνληθνύ εκπνξίνπ 

 

Ιζηνξηθά ζηνηρεία 

  

Η ηδέα, ζηελ νπνία βαζίδεηαη ην ειεθηξνληθφ εκπφξην, είλαη ζρεηηθά πξφζθαηε, αλ 

ιάβεη θαλείο ππφςε ηνπ φηη ην πξψην "κεραλνγξαθεκέλν" πνιπθαηάζηεκα ζηνλ 

θφζκν δεκηνπξγήζεθε ην 1970. Πξφθεηηαη γηα ην Telemart, ζην αλ Νηηέγθν ηεο 

Καιηθφξληα. Σφηε, δελ ππήξρε Ίληεξλεη θαη νη πειάηεο ρξεζηκνπνηνχζαλ ην 

αλαινγηθφ ηειέθσλν, γηα λα επηιέμνπλ ηα πξντφληα, πνπ επηζπκνχζαλ λα ηνπο 

απνζηαινχλ ζην ζπίηη. ήκεξα, 30 ρξφληα κεηά ην πξψην πείξακα, ην ειεθηξνληθφ 

εκπφξην είλαη πηα δηαδεδνκέλν, γλσζηφ ζηελ πιεηνςεθία ησλ ρξεζηψλ ηνπ Ίληεξλεη,  

έζησ θη αλ ρξεζηκνπνηείηαη ειάρηζηα. 
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Γεθαεηία ηνπ 1970 

 Δκθαλίδνληαη ηα ζπζηήκαηα ειεθηξνληθήο κεηαθνξάο ρξεκαηηθψλ πφξσλ (EFT)  

κεηαμχ ηξαπεδψλ, πνπ ρξεζηκνπνηνχλ αζθαιή ηδησηηθά δίθηπα. Σα ζπζηήκαηα EFT  

αιιάδνπλ ηε κνξθή ησλ αγνξψλ.  

 

Γεθαεηία ηνπ 1980 

 Οη ηερλνινγίεο ειεθηξνληθήο επηθνηλσλίαο πνπ βαζίδνληαη ζηελ αξρηηεθηνληθή ηεο 

αληαιιαγήο κελπκάησλ (ζπζηήκαηα EDI θαη ειεθηξνληθφ ηαρπδξνκείν) απνθηνχλ 

ζεκαληηθή δηάδνζε. Πνιιέο δξαζηεξηφηεηεο, πνπ παξαδνζηαθά δηεθπεξαηψλνληαλ κε 

βαζηθφ κέζν ην ραξηί, κπνξνχλ πιένλ λα γίλνπλ ηαρχηεξα θαη κε κηθξφηεξν θφζηνο.  

Οη ζπλαιιαγέο, πνπ παιαηφηεξα απαηηνχζαλ έληππα, φπσο παξαγγειίεο αγνξάο,  

ζπλνδεπηηθά έγγξαθα θαη επηηαγέο πιεξσκήο, κπνξνχλ λα γίλνπλ θαηά έλα κέξνο ή 

ζην ζχλνιφ ηνπο ειεθηξνληθά - κε δνκεκέλν ηξφπν ράξε ζηα ζπζηήκαηα EDI ή κέζσ 

ηνπ ειεθηξνληθνχ ηαρπδξνκείνπ.  

 

Σέιε ηεο δεθαεηίαο ηνπ 1980 - αξρέο ηεο δεθαεηίαο ηνπ 1990  

 Σα ειεθηξνληθά δίθηπα πξνζθέξνπλ κηα λέα κνξθή θνηλσληθήο επηθνηλσλίαο, κε 

δπλαηφηεηεο φπσο ειεθηξνληθφ ηαρπδξνκείν (e-mail), ειεθηξνληθή δηάζθεςε 

(conferencing) θαη ειεθηξνληθή ζπλνκηιία (IRC), νκάδεο ζπδήηεζεο (newsgroups,  

forums), κεηαθνξά αξρείσλ (FTP) θηι. Η πξφζβαζε ζην δίθηπν γίλεηαη θζελφηεξε 

ιφγσ ηεο δηεζλνχο απειεπζέξσζεο ηεο αγνξάο ηειεπηθνηλσληψλ.  

 

Μέζα ηεο δεθαεηίαο ηνπ 1990  

 Η εκθάληζε ηνπ Παγθφζκηνπ Ιζηνχ (WWW) ζην Internet θαη ε επηθξάηεζε ησλ 

πξνζσπηθψλ ειεθηξνληθψλ ππνινγηζηψλ (PC) πνπ ρξεζηκνπνηνχλ ιεηηνπξγηθά 

ζπζηήκαηα ηχπνπ Windows, πξνζθέξνπλ κεγάιε επθνιία ρξήζεο ιχλνληαο ην 

πξφβιεκα ηεο δεκνζίεπζεο θαη ηεο εχξεζεο πιεξνθνξηψλ ζην Γηαδίθηπν. Σν 

ειεθηξνληθφ εκπφξην γίλεηαη έλαο πνιχ θζελφηεξνο ηξφπνο γηα ηελ πξαγκαηνπνίεζε 

κεγάινπ φγθνπ ζπλαιιαγψλ, ελψ ζπγρξφλσο δηεπθνιχλεη ηελ παξάιιειε ιεηηνπξγία 

πνιιψλ δηαθνξεηηθψλ επηρεηξεκαηηθψλ δξαζηεξηνηήησλ, επηηξέπνληαο ζε κηθξέο 

επηρεηξήζεηο λα αληαγσληζηνχλ κεγαιχηεξεο, κε πνιχ επλντθφηεξεο πξνυπνζέζεηο.  

 

Σέιε ηεο δεθαεηίαο ηνπ 1990 

 Η θαζηέξσζε κεζφδσλ θξππηνγξάθεζεο ηνπ πεξηερνκέλνπ θαη εμαθξίβσζεο ηεο 

ηαπηφηεηαο ηνπ απνζηνιέα ειεθηξνληθψλ κελπκάησλ, θαζψο θαη ε ζρεηηθή 

πξνζαξκνγή ηεο λνκνζεζίαο ζηνπο ηνκείο ησλ εηζαγσγψλ-εμαγσγψλ θαη ησλ 

επηθνηλσληψλ, θαζηζηνχλ δπλαηή ηελ πξαγκαηνπνίεζε αζθαιψλ δηεζλψλ 

ειεθηξνληθψλ ζπλαιιαγψλ. 

 

Ηιεθηξνληθό εκπόξην θαη νθέιε γηα ηνπο Καηαλαισηέο  

 

• Μπνξνχκε λα αγνξάζνπκε πξντφληα ή ππεξεζίεο, πνπ επηζπκνχκε, φπνηε 

ζειήζνπκε, 24 ψξεο ην 24σξν, 7 εκέξεο ηελ εβδνκάδα, φπνπ θη αλ 

βξηζθφκαζηε.  

• Μπνξνχκε λα επηζθεθηνχκε, εχθνια θαη γξήγνξα, πνιιά ειεθηξνληθά 

θαηαζηήκαηα θαη λα ζπγθξίλνπκε ηηο ηηκέο θαη ηα ραξαθηεξηζηηθά ησλ εηδψλ 

πνπ καο ελδηαθέξνπλ, πξηλ αγνξάζνπκε απηφ πνπ επηζπκνχκε.  

• Μπνξνχκε λα ελεκεξσζνχκε, πιεξέζηεξα, γηα ην πξντφλ ή ηελ ππεξεζία πνπ 

αλαδεηάκε.  

• Γιηηψλνπκε ρξφλν θαη ηαιαηπσξία, κεηψλνληαο ηηο κεηαθηλήζεηο καο.  
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• Πνιιά ειεθηξνληθά θαηαζηήκαηα θάλνπλ εηδηθέο εθπηψζεηο, ζηνπο πειάηεο 

ηνπο.  

• Η λνκνζεζία γηα ηελ πξνζηαζία ηνπ Καηαλαισηή, φηαλ πξφθεηηαη γηα αγνξέο 

απφ απφζηαζε, φπσο είλαη νη ειεθηξνληθέο αγνξέο δηαζθαιίδεη ηα δηθαηψκαηά 

ηνπο (π.ρ. ην δηθαίσκα ππαλαρψξεζεο θ.ιπ.)  

 

Ηιεθηξνληθό εκπόξην θαη νθέιε γηα ηνπο πξνκεζεπηέο 

 

Σν ειεθηξνληθφ εκπφξην απνηειεί κηα ελαιιαθηηθή πξφηαζε, γηα ην παξαδνζηαθφ 

εκπφξην.  

Πνπιψληαο on-line, ν έκπνξνο κεηψλεη ή θαη θαηαξγεί ηε δηθή ηνπ αιπζίδα δηαλνκήο 

εκπνξεπκάησλ, ειαρηζηνπνηψληαο πάγηα έμνδα, φπσο ελνίθηα ή πξνζσπηθφ. Οη 

κηθξνκεζαίνη 

παξαγσγνί κπνξνχλ λα πξνσζήζνπλ ηα πξντφληα ηνπο, αθφκα θαη ζε αγνξέο, νη 

νπνίεο, ππφ νπνηεζδήπνηε άιιεο ζπλζήθεο, ζα ήηαλ απξφζηηεο γηα απηνχο. 

 

Δπίπεδν Αζθαιώλ πλδέζεσλ (SSL - Secure Sockets Layer) 

 

 Σν πξσηφθνιιν απηφ ζρεδηάζηεθε πξνθεηκέλνπ λα πξαγκαηνπνηεί αζθαιή 

ζχλδεζε κε ηνλ εμππεξεηεηή (server). Σν SSL ρξεζηκνπνηεί "θιεηδί" δεκφζηαο 

θξππηνγξάθεζεο, κε ζθνπφ λα πξνζηαηεχεη ηα δεδνκέλα θαζψο "ηαμηδεχνπλ" κέζα 

ζην Internet. 

 

 

 

Πηζηνπνίεζε θαη αζθάιεηα 

 

 Γηα ηελ αζθάιεηα ησλ ειεθηξνληθψλ ζπλαιιαγψλ ρξεζηκνπνηνχληαη επξέσο ηα 

firewalls. Σν firewall απνηειεί ινγηζκηθφ ή πιηθφ, πνπ επηηξέπεη κφλν ζηνπο 

εμσηεξηθνχο ρξήζηεο πνπ έρνπλ ηα θαηάιιεια δηθαηψκαηα, λα πξνζπειάζνπλ ην 

πξνζηαηεπφκελν δίθηπν. Έλα firewall επηηξέπεη ζηνπο εζσηεξηθνχο ρξήζηεο λα έρνπλ 

πιήξε πξφζβαζε ζηηο παξερφκελεο ππεξεζίεο, ελψ νη εμσηεξηθνί ρξήζηεο πξέπεη λα 

πηζηνπνηεζνχλ. Τπάξρνπλ πνιινί ηχπνη firewalls, θαζέλαο απφ ηνπο νπνίνπο παξέρεη 

δηαθνξεηηθά επίπεδα πξνζηαζίαο. Ο ζπλεζέζηεξνο ηξφπνο ρξεζηκνπνίεζεο ελφο 

firewall είλαη ε ηνπνζέηεζε ελφο ππνινγηζηή ή δξνκνινγεηή κεηαμχ ζπγθεθξηκέλνπ 

δηθηχνπ θαη ηνπ Internet, θαη ε παξαθνινχζεζε φιεο ηεο θπθινθνξίαο κεηαμχ ηνπ 

εμσηεξηθνχ θαη ηνπ ηνπηθνχ δηθηχνπ.  

 Η εκπηζηεπηηθή πιεξνθνξία πνπ δηαθηλείηαη ζην δίθηπν κπνξεί λα πξνζηαηεπζεί 

κε θξππηνγξάθεζεθαη ρξήζε κπζηηθψλ θσδηθψλ. Η αζθάιεηα ηνπ ειεθηξνληθνχ 

εκπνξίνπ βαζίδεηαη θαηεμνρήλ ζηελ θξππηνγξάθεζε, δειαδή ζηελ θσδηθνπνίεζε ηνπ 

κεηαδηδφκελνπ θεηκέλνπ θαηά ηέηνην ηξφπν ψζηε λα κπνξεί λα απνθξππηνγξαθεζεί 

κφλν κε ηε ρξήζε ηνπ εηδηθνχ θιεηδηνχ απνθξππηνγξάθεζεο. Η 

θξππηνγξάθεζεζπλνδεχεηαη πνιιέο θνξέο θαη απφ ηελ ςεθηαθή ππνγξαθήηνπ 

απνζηνιέα, έηζη ψζηε ν παξαιήπηεο λα κπνξεί λα βεβαησζεί γηα ηελ ηαπηφηεηα ηνπ 

πξψηνπ. 

 

2.2.5 Έξεπλα γηα ην ειεθηξνληθό εκπόξην ζηελ Διιάδα 
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 ε ξπζκνύο αλάπηπμεο 25% ην Ηιεθηξνληθό Δκπόξην B-C ην 2013 ζηελ Διιάδα 

 

Οινθιεξψζεθε πξφζθαηα ε εηήζηα έξεπλα ηνπ ειεθηξνληθνχ εκπνξίνπ B-C πνπ πξαγκαηνπνηεί 

εδψ θαη 5 ρξφληα ην Δξγαζηήξην Ηιεθηξνληθνχ Δκπνξίνπ (ELTRUN) ηνπ Οηθνλνκηθνχ 

Παλεπηζηεκίνπ Αζελψλ. Σα θχξηα ζπκπεξάζκαηα παξνπζηάζζεθαλ ηελ Σξίηε 3 Γεθεκβξίνπ ζην 

9ν πλέδξην Καηλνηνκίαο ηνπ Γηαδηθηχνπ θαη Ηιεθηξ. Δπηρεηξείλ (πνπ νξγαλψλεη ην ΔΙΠ / ΔΔΓΔ 

θαη ην ELTRUN / ΟΠΑ) 

Σν 35% ησλ ρξεζηψλ Internet ζηελ Διιάδα (πεξίπνπ 2.2εθ) έθαλα ηνπιάρηζηνλ κηα αγνξά 

πξντφληνο / ππεξεζίαο on-line. Παξά ην φηη ε on-line αγνξά θηλήζεθε κε 25% ξπζκνχο 

αλάπηπμεο ζε ζρέζε κε ην 2012, αθφκε παξακέλεη ζε ρακειά επίπεδα, αθνχ ε αληίζηνηρε 

Δπξσπατθή αγνξά ζα θζάζεη ηα €350 δηο κε ην 70% ησλ ρξεζηψλ Internet λα αγνξάδνπλ on-line. 

Απηφ δείρλεη θαη ηελ πξννπηηθή ηεο Διιεληθήο αγνξάο πνπ απφ ηα €3.2 δηο κπνξεί θάησ απφ 

πξνυπνζέζεηο λα θζάζεη ηα επφκελα ρξφληα ηα €6 δηο. 

Σα θχξηα ραξαθηεξηζηηθά ησλ Διιήλσλ on-line θαηαλαισηψλ είλαη: 

 

• Έρνπλ κηα ζρεηηθή πιένλ εκπεηξία 5,5 εηψλ θαηά κέζν φξν on-line αγνξψλ. Σν 18% 

μεθίλεζε ηηο on-line αγνξέο ην 2013 πνπ δηθαηνινγεί ζε κεγάιν βαζκφ ηελ αλάπηπμε ηεο αγνξάο 

ην 2013 ζε ζρέζε κε ην 2012 

• Η κέζε αμία ησλ on-line ζπλαιιαγψλ θπκάλζεθε ζηα €1500 κε ηελ κεξίδα ηνπ ιένληνο 

λα ηελ παίξλνπλ ε αγνξά ππεξεζηψλ φπσο: ηαμηδησηηθέο ππεξεζίεο (αγνξά εηζηηεξίσλ), δηαλνκή 

ζε θαηαιχκαηα, αζθάιεηεο απηνθηλήησλ, ηειεπηθνηλσληαθέο ππεξεζίεο, εηζηηήξηα γηα εθδειψζεηο 

• Σν 40% ζα απμήζνπλ ηηο on-line αγνξέο ηνπο ην 2014, ελψ ιφγσ ηεο νηθνλνκηθήο θξίζεο 

ην 20% ζα ηηο κεηψζεη 

• Η ζεκαζία ηνπ δηαδηθηχνπ ζηηο αγνξέο ζπλνιηθά θαίλεηαη θαη απφ ην γεγνλφο φηη γηα 

ηνπο on-line αγνξαζηέο ην 40% ησλ αγνξψλ ζε θπζηθά θαηαζηήκαηα / εηαηξίεο γίλεηαη αθνχ γίλεη 

ζνβαξή δηεξεχλεζε / έξεπλα θαη ζχγθξηζε ηηκψλ ζην Γηαδίθηπν 

• Μφλν ην 60-65% ησλ ζπλνιηθψλ on-line αγνξψλ θαηεπζχλεηαη ζε Διιεληθά sites. Απηφ 

θαηαδεηθλχεη θαη ηελ πξννπηηθή ησλ Διιεληθψλ ςεθηαθψλ επηρεηξήζεσλ θάησ απφ 

πξνυπνζέζεηο ζην κέιινλ, αθνχ ην αληίζηνηρν λνχκεξν ζηελ Δπξψπε είλαη θνληά ζην 90% 

• Οη Έιιελεο on-line αγνξαζηέο ζπλήζσο αγνξάδνπλ απφ 4-5 Διιεληθά sites θαη 3-4 μέλα 

sites 
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4 ζρευνα για αγορζσ μζςω internet 

 

Σν ζρήκα θαηαγξάθεη ηα πνζνζηά ησλ Διιήλσλ on-line αγνξαζηψλ πνπ έθαλαλ ηνπιάρηζηνλ κηα 

on-line αγνξά (απφ Διιεληθφ ή μέλν site) ην πξψην ελλεάκελν ηνπ 2013 ζηηο ζπγθεθξηκέλεο 

γλσζηέο θαηεγνξίεο πξντφλησλ ππεξεζηψλ. Σα βαζηθά ζπκπεξάζκαηα είλαη: 

 

• ε ζρέζε κε ην 2012 φιεο ζρεδφλ νη θαηεγνξίεο είραλ κεγαιχηεξα πνζνζηά ησλ on-line 

αγνξαζηψλ λα αγνξάδνπλ θάηη 

• Οη θαηεγνξίεο πνπ είραλ ηελ κεγαιχηεξε αλάπηπμε ην 2013 είλαη δηακνλή ζε 

θαηαιχκαηα (ιφγσ πνιιψλ sites πνπ πξνζθέξνπλ ηηο ππεξεζίεο απηέο αιιά θαη ηεο κείσζεο ηνπ 

ζρεηηθνχ budget ησλ θαηαλαισηψλ πνπ ςάρλνπλ επθαηξίεο ζην Internet), εηζηηήξηα γηα 

εθδειψζεηο (πιένλ ππάξρνπλ πνιχ θαιέο ππεξεζίεο πνπ πξνζθέξνληαη κε αζθάιεηα απφ 

εηαηξίεο), ππεξεζίεο ηειεπηθνηλσληψλ (φινη νη ηειεπηθνηλσληαθνί νξγαληζκνί πξνζθέξνπλ 

πξνρσξεκέλεο ππεξεζίεο on-line ζηνπο πειάηεο ηνπο πνπ θζάλνπλ κέρξη θαη 

πξνζσπνπνηεκέλεο), αζθάιεηεο (είλαη πιένλ ε θχξηα ζηξαηεγηθή φινπ ηνπ θιάδνπ ιφγσ ηεο 

εηζφδνπ δπλακηθψλ λέσλ on-line εηαηξηψλ), είδε θαξκαθείνπ (ιφγσ ηεο εκπινθήο πνιιψλ 

θαξκαθείσλ ζην ςεθηαθφ θαλάιη θαη ηηο επθαηξίεο ζηηο ηειηθέο ηηκέο γηα βηηακίλεο, 

ζπκπιεξψκαηα δηαηξνθήο θαη ΜΗΤΦΑ) 
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• Παξ’ φηη γηα ηα θπζηθά πξντφληα ππήξραλ πνιχ πεξηζζφηεξεο παξαγγειίεο απφ φηη γηα ηηο 

ππεξεζίεο, νη ηειεπηαίεο είραλ πνιχ κεγαιχηεξε ρξεκαηηθή αμία 

 

5 διάγραμμα για εμπιςτοςφνη e-shops 

ζνλ αθνξά ηνπο ιφγνπο πνπ νη Έιιελεο on-line θαηαλαισηέο εκπηζηεχνληαη θαη αγνξάδνπλ απφ 

έλα ειεθηξνληθφ θαηάζηεκα, ηα ζπκπεξάζκαηα είλαη: 

• Οη πξψηνη ηξείο ιφγνη ζρεηίδνληαη κε ηελ αζθάιεηα / πηζηνπνίεζε πνπ ζρεηίδεηαη κε ηελ 

έιιεηςε εκπεηξίαο γηα αγνξέο απφ απφζηαζε αιιά θαη ηελ ―δπζπηζηία‖ πνπ εθθξάδεη ηα 

ηειεπηαία ρξφληα γεληθά ν Έιιελαο θαηαλαισηήο γηα ηηο αγνξέο ηνπ 

• Παξ’ φια απηά ην 60% πηζαλφλ ή ζίγνπξα ζα αγφξαδε απφ έλα on-line θαηάζηεκα αθφκα 

θαη αλ δελ θάιππηε ηα παξαπάλσ θξηηήξηα αιιά είρε ρακειέο ηηκέο θαη θαιέο πξνζθνξέο 

http://www.eltrun.gr/e-commerce-survey-2013/ 
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2.2.6 Ηιεθηξνληθό θαηάζηεκα (e-shop) 

 

 
6 e-shop 

Σα ειεθηξνληθά θαηαζηήκαηα είλαη web sites ζηα νπνία δηεθπεξαηφλνληαη ζπλαιιαγέο 

ειεθηξνληθνχ εκπνξίνπ. Σα sites απηά παξέρνπλ κία εηθνληθή βηηξίλα φπνπ κπνξεί λα 

ελεξγνπνηεζεί ε αληαιιαγή αγαζψλ ή ππεξεζηψλ.  

Σν ειεθηξνληθφ θαηάζηεκα πξέπεη λα ιεηηνπξγεί κε ηνπο ίδηνπο θαλφλεο πνπ ιεηηνπξγέη έλα 

θαλνληθφ θαηάζηεκα. Πξεπεη λα έρεη ηε δπλαηφηεηα λα παξέρεη εκπνξεχκαηα, λα θάλεη 

απνγξαθέο,  λα δηεθπεξαηψλεη ζπλαιιαγέο θαη λα ζηέιλεη ηα εκπνξεχκαηα ζηνπο πειάηεο. 

Πνιιέο βέβαηα απφ απηέο ηηο ιεηηνπξγίεο εθηεινχληαη απφ άιιεο εηαηξίεο. Γηα παξάδεηγκα, έλαο 

ηξίηνο θνξέαο ζα κπνξνχζε λα αλαιάβεη ηηο θηλήζεηο ησλ πηζησηηθψλ θαξηψλ θαη ε απνγξαθή ζα 

κπνξνχζε λα πξνέξρεηαη απφ θάπνπ αιινχ. 

ηνηρεία ελνο ειεθηξνληθνχ θαηαζηήκαηνο: 

Έλα ειεθηξνληθφ θαηάζηεκα είλαη έλα πνιχ ζχλζεην, αιιειεπηδξφλ web site. Ωε ηέηνην 

απαηηείηαη πξνζεθηηθφ πιάλν θαη ζθέςε γηα ηε ζρεδίαζε. Σα πεξηζζφηεξα web sites αθνινπζνχλ 

παξφκνηα δνκή.  

 Μία ή πεξηζζφηεξεο ζειίδεο επηζθφπεζεο ησλ πξντφλησλ, φπνπ παξνπζηάδνληαη φια ηα 

πξντφληα κε ζχληνκεο πεξηγξαθέο 

 Μία ζειίδα κε ιεπηνκέξεηεο γηα ην πξντφλ, θαηαζθεπαζκέλε δπλακηθά γηα θάζε πξντφλ 

 Μία ζειίδα αλαδήηεζεο πνπ ζπλήζσο ζπλδέεηαη κε ηε ζειίδα επηζθφπεζεο ησλ 

πξντφλησλ 

 Μία ζειίδα θαξνηζηνχ, ηελ νπνία ζα ζπλδέζεηε κε φιεο ηηο ζειίδεο πνπ δηαζέηνπλ έλα 

εηθνλίδην ή κία ζχλδεζε view cart, παξνπζηάδνληαο ζην ρξήζηε ηα ζηνηρεία πνπ 

ππάξρνπλ ηε δεδνκέλε ζηηγκή ζην θαξφηζη 

 Μία ή πεξηζζφηεξεο ζειίδεο ηακείνπ, ζηηο νπνίεο ν ρξήζηεο θαιείηε λα πιεξψζεη γηα ηα 

πξντφληα πνπ ζέιεη λα αγνξάζεη. 
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 Μία ζειίδα εγγξαθήο, γηα λα κπνξεί ν ρξήζηεο λα πξνζσπνπνηήζεη ηελ επίζθεςή ηνπ, 

πξνζζέηνληαο ζρεηηθέο πιεξνθνξίεο αγνξάο ή εγγξαθήο, φπσο θαη κία ζειίδα ζχλδεζεο 

γηα κειινληηθέο επηζθέςεηο, γηα λα αλαγλσξίζεη ακέζσο, καδί κε ηηο πξνηηκήζεηο ηνπ. 

 Μία ζειίδα επηβεβαίσζεο παξαγγειίαο, φπνπ ν ρξήζηεο επηβεβαηψλεη ηελ παξαγγειία 

 Μία επραξηζηήξηα ζειίδα πνπ παξνπζηάδεη ηηο ιεπηνκέξηεο κίαο επηηπρνχο ζπλαιιαγήο 

 

Κεθάιαην 3: Πξνγξάκκαηα θαη γιώζζεο πινπνίεζεο 

 

3.1 Xampp 

 

 

7 xampp 

 

Το XAMPP [1] είναι ζνα πακζτο προγραμμάτων ελεφθερου λογιςμικοφ, λογιςμικοφ ανοικτοφ 
κϊδικα και ανεξαρτήτου πλατφόρμασ το οποίο περιζχει το εξυπηρετητή ιςτοςελίδων http 
Apache, την βάςη δεδομζνων MySQL και ζνα διερμηνζα για κϊδικα γραμμζνο ςε γλϊςςεσ 
προγραμματιςμοφ PHP και Perl. 
 
 
Ετυμολογία 
 
Το XAMPP είναι ακρωνφμιο και αναφζρεται ςτα παρακάτω αρχικά: 
X (αναφζρεται ςτο «cross-platform» που ςημαίνει λογιςμικό ανεξάρτητο πλατφόρμασ) 
Apache HTTP εξυπηρετητήσ 
MySQL 
PHP 
Perl 
Το XAMPP είναι ζνα ελεφθερο λογιςμικό το οποίο περιζχει ζνα εξυπηρετητή ιςτοςελίδων το 
οποίο μπορεί να εξυπηρετεί και δυναμικζσ ιςτοςελίδεσ τεχνολογίασ PHP/MySQL. Είναι 
ανεξάρτητο πλατφόρμασ και τρζχει ςε Microsoft Windows, Linux, Solaris, and Mac OS Xκαι 
χρηςιμοποιείται ωσ πλατφόρμα για την ςχεδίαςη και ανάπτυξη ιςτοςελίδων με την τεχνολογίεσ 
όπωσ PHP, JSP και Servlets. 
  

 

http://el.wikipedia.org/wiki/XAMPP#cite_note-kaiseidlerinterview-1
http://el.wikipedia.org/wiki/%CE%95%CE%BB%CE%B5%CF%8D%CE%B8%CE%B5%CF%81%CE%BF_%CE%BB%CE%BF%CE%B3%CE%B9%CF%83%CE%BC%CE%B9%CE%BA%CF%8C
http://el.wikipedia.org/wiki/%CE%9B%CE%BF%CE%B3%CE%B9%CF%83%CE%BC%CE%B9%CE%BA%CF%8C_%CE%B1%CE%BD%CE%BF%CE%B9%CE%BA%CF%84%CE%BF%CF%8D_%CE%BA%CF%8E%CE%B4%CE%B9%CE%BA%CE%B1
http://el.wikipedia.org/wiki/%CE%9B%CE%BF%CE%B3%CE%B9%CF%83%CE%BC%CE%B9%CE%BA%CF%8C_%CE%B1%CE%BD%CE%BF%CE%B9%CE%BA%CF%84%CE%BF%CF%8D_%CE%BA%CF%8E%CE%B4%CE%B9%CE%BA%CE%B1
http://el.wikipedia.org/wiki/%CE%91%CE%BD%CE%B5%CE%BE%CE%AC%CF%81%CF%84%CE%B7%CF%84%CE%BF_%CF%80%CE%BB%CE%B1%CF%84%CF%86%CF%8C%CF%81%CE%BC%CE%B1%CF%82_(%CE%BB%CE%BF%CE%B3%CE%B9%CF%83%CE%BC%CE%B9%CE%BA%CF%8C)
http://el.wikipedia.org/wiki/Apache_HTTP_%CE%B5%CE%BE%CF%85%CF%80%CE%B7%CF%81%CE%B5%CF%84%CE%B7%CF%84%CE%AE%CF%82
http://el.wikipedia.org/wiki/Apache_HTTP_%CE%B5%CE%BE%CF%85%CF%80%CE%B7%CF%81%CE%B5%CF%84%CE%B7%CF%84%CE%AE%CF%82
http://el.wikipedia.org/wiki/MySQL
http://el.wikipedia.org/wiki/%CE%94%CE%B9%CE%B5%CF%81%CE%BC%CE%B7%CE%BD%CE%AD%CE%B1%CF%82_(%CF%85%CF%80%CE%BF%CE%BB%CE%BF%CE%B3%CE%B9%CF%83%CF%84%CE%AD%CF%82)
http://el.wikipedia.org/wiki/%CE%93%CE%BB%CF%8E%CF%83%CF%83%CE%B1_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CE%BF%CF%8D
http://el.wikipedia.org/wiki/%CE%93%CE%BB%CF%8E%CF%83%CF%83%CE%B1_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CE%BF%CF%8D
http://el.wikipedia.org/wiki/PHP
http://el.wikipedia.org/wiki/Perl
http://el.wikipedia.org/wiki/Apache_HTTP_%CE%B5%CE%BE%CF%85%CF%80%CE%B7%CF%81%CE%B5%CF%84%CE%B7%CF%84%CE%AE%CF%82
http://el.wikipedia.org/wiki/MySQL
http://el.wikipedia.org/wiki/PHP
http://el.wikipedia.org/wiki/Perl
http://el.wikipedia.org/wiki/Microsoft_Windows
http://el.wikipedia.org/wiki/Linux
http://el.wikipedia.org/wiki/Solaris_(%CE%BB%CE%B5%CE%B9%CF%84%CE%BF%CF%85%CF%81%CE%B3%CE%B9%CE%BA%CF%8C_%CF%83%CF%8D%CF%83%CF%84%CE%B7%CE%BC%CE%B1)
http://el.wikipedia.org/wiki/Mac_OS_X
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Γπλαηόηεηεο θαη απαηηήζεηο  

 

Σν XAMPP πξνυπνζέηεη κφλν ηα ινγηζκηθά ζπκπίεζεο αξρείσλ zip, tar, 7z ή exe θαηά ηελ 

δηάξθεηα ηεο εγθαηάζηαζεο. Σν XAMPP έρεη δπλαηφηεηα αλαβάζκηζεο ζε λέεο εθδφζεηο ηνπ 

εμππεξεηεηή ηζηνζειίδσλ http Apache, ηεο βάζεο δεδνκέλσλ MySQL, ηεο γιψζζαο PHP θαη 

Perl. Σν XAMPP ζπκπεξηιακβάλεη επίζεο ηα παθέηα OpenSSL θαη ην phpMyAdmin. 

 

 

 

Χξήζε  

 

Δπίζεκα νη ζρεδηαζηέο ηνπ XAMPP πξνφξηδαλ ην ινγηζκηθφ σο εξγαιείν αλάπηπμεο θαη δνθηκήο 

ηζηνζειίδσλ ηνπηθά ζηνλ ππνινγηζηή ρσξίο λα είλαη απαξαίηεηε ε ζχλδεζε ζην δηαδίθηπν. Γηα 

λα είλαη δπλαηή ε ρξήζε ηνπ, πνιιέο ζεκαληηθέο ιεηηνπξγίεο αζθάιεηαο έρνπλ 

απελεξγνπνηεζεί 
[3]

. ηελ πξάμε ην XAMPP νξηζκέλεο θνξέο ρξεζηκνπνηείηαη θαη γηα ηελ 

θηινμελία ηζηνζειίδσλ. Τπάξρεη εηδηθφ εξγαιείν ην νπνίν πεξηέρεηαη ζην XAMPP γηα ηελ 

πξνζηαζία κε θσδηθφ ησλ ζεκαληηθψλ κεξψλ. Σν XAMPP ππνζηεξίδεη ηελ δεκηνπξγία θαη 

δηαρείξηζε βάζεσλ δεδνκέλσλ ηχπνπ MySQL θαη SQLite. 

ηαλ ην XAMPP εγθαηαζηαζεί ζηνλ ηνπηθφ ππνινγηζηή δηαρεηξίδεηαη ηνλ localhost σο έλα 

απνκαθξπζκέλν θφκβν, ν νπνίνο ζπλδέεηαη κε ην πξσηφθνιιν κεηαθνξάο αξρείσλ FTP. Η 

ζχλδεζε ζηνλ localhost κέζσ ηνπ FTP κπνξεί λα γίλεη κε ην φλνκα ρξήζηε «newuser» θαη ην 

θσδηθφ «wampp». Γηα ηελ βάζε δεδνκέλσλ MySQL ππάξρεη ν ρξήζηεο «root» ρσξίο θσδηθφ 

πξφζβαζεο. 

 

3.2 Apache 

 

8 apache http server 

Ο Apache HTTP  γλσζηφο θαη απιά ζαλ Apache είλαη έλαο εμππεξεηεηήο ηνπ παγθφζκηνπ 

ηζηνχ (web). πνηε έλαο ρξήζηεο επηζθέπηεηαη έλα ηζηφηνπν ην πξφγξακκα πινήγεζεο (browser) 

επηθνηλσλεί κε έλαλ δηαθνκηζηή (server) κέζσ ηνπ πξσηνθφιινπHTTP, ν νπνίνο παξάγεη ηηο 

ηζηνζειίδεο θαη ηηο απνζηέιιεη ζην πξφγξακκα πινήγεζεο. O Apache είλαη έλαο απφ ηνπο 

δεκνθηιέζηεξνπο εμππεξεηεηέο ηζηνχ, ελ κέξεη γηαηί ιεηηνπξγεί ζε δηάθνξεο πιαηθφξκεο φπσο 

ηα Windows, ην Linux, ην Unix θαη ηνMac OS X. Κπθινθφξεζε ππφ ηελ άδεηα ινγηζκηθνχ 

Apache θαη είλαη ινγηζκηθφ αλνηρηνχ θψδηθα. πληεξείηαη απφ κηα θνηλφηεηα αλνηθηνχ θψδηθα 

κε επηηήξεζε απφ ην Ίδξπκα Λνγηζκηθνχ Apache (Apache Software Foundation). 

http://el.wikipedia.org/wiki/XAMPP#cite_note-3
http://el.wikipedia.org/wiki/%CE%95%CE%BE%CF%85%CF%80%CE%B7%CF%81%CE%B5%CF%84%CE%B7%CF%84%CE%AE%CF%82
http://el.wikipedia.org/wiki/%CE%A0%CE%B1%CE%B3%CE%BA%CF%8C%CF%83%CE%BC%CE%B9%CE%BF%CF%82_%CE%B9%CF%83%CF%84%CF%8C%CF%82
http://el.wikipedia.org/wiki/%CE%A0%CE%B1%CE%B3%CE%BA%CF%8C%CF%83%CE%BC%CE%B9%CE%BF%CF%82_%CE%B9%CF%83%CF%84%CF%8C%CF%82
http://el.wikipedia.org/wiki/%CE%99%CF%83%CF%84%CF%8C%CF%84%CE%BF%CF%80%CE%BF%CF%82
http://el.wikipedia.org/wiki/%CE%94%CE%B9%CE%B1%CE%BA%CE%BF%CE%BC%CE%B9%CF%83%CF%84%CE%AE
http://el.wikipedia.org/wiki/HTTP
http://el.wikipedia.org/wiki/Windows
http://el.wikipedia.org/wiki/Linux
http://el.wikipedia.org/wiki/Unix
http://el.wikipedia.org/wiki/Mac_OS_X
http://el.wikipedia.org/wiki/%CE%9B%CE%BF%CE%B3%CE%B9%CF%83%CE%BC%CE%B9%CE%BA%CF%8C_%CE%B1%CE%BD%CE%BF%CE%B9%CF%87%CF%84%CE%BF%CF%8D_%CE%BA%CF%8E%CE%B4%CE%B9%CE%BA%CE%B1
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Ο Apache ρξεζηκνπνηείηαη θαη ζε ηνπηθά δίθηπα ζαλ δηαθνκηζηήο ζπλεξγαδφκελνο κε ζπζηήκαηα 

δηαρείξηζεο Βάζεο Γεδνκέλσλ π.ρ.Oracle, MySQL. 

Η πξψηε ηνπ έθδνζε, γλσζηή σο NCSA HTTPd, δεκηνπξγήζεθε απφ ηνλ Robert McCool θαη 

θπθινθφξεζε ην 1993. Θεσξείηαη φηη έπαημε ζεκαληηθφ ξφιν ζηελ αξρηθή επέθηαζε 

ηνπ παγθφζκηνπ ηζηνχ. Ήηαλ ε πξψηε βηψζηκε ελαιιαθηηθή επηινγή πνπ παξνπζηάζηεθε 

απέλαληη ζηνλ εμππεξεηεηή http ηεο εηαηξείαο Netscape θαη απφ ηφηε έρεη εμειηρζεί ζην ζεκείν 

λα αληαγσλίδεηαη άιινπο εμππεξεηεηέο βαζηζκέλνπο ζην Unix ζε ιεηηνπξγηθφηεηα θαη απφδνζε. 

Απφ ην 1996 ήηαλ απφ ηνπο πην δεκνθηιείο φκσο απφ ηνλ Μάξηην ηνπ 2006 έρεη κεησζεί ην 

πνζνζηφ ηεο εγθαηάζηαζήο ηνπ θπξίσο απφ ηνλ Microsoft Internet Information Services θαη ηελ 

πιαηθφξκα .NET. Σνλ Οθηψβξην ηνπ 2007 ην κεξίδην ηνπ ήηαλ 47.73% απφ φινπο ηνπο 

ηζηνηφπνπο. 

http://el.wikipedia.org/wiki/Apache_HTTP_%CE%B5%CE%BE%CF%85%CF%80%CE%B7%

CF%81%CE%B5%CF%84%CE%B7%CF%84%CE%AE%CF%82 

 

3.3 PHP 

 

 

9 php logo 

Η ΡΗΡ είλαη κηα γιψζζα script απφ ηελ πιεπξά ηνπ δηαθνκηζηή , ζρεδηαζκέλε εηδηθά 

γηα ην Web .Μέζα ζε κηα HTML ζειίδα κπνξείηε λα ελζσκαηψζεηε PHP θψδηθα ,  

πνπ ζα εθηειείηαη θάζε θνξά πνπ ζα επηζθέπηεζηε ηε ζειίδα. Ο ΡΗΡ θψδηθαο 

κεηαθξάδεηε ζην Web δηαθνκηζηή θαη δεκηνπξγεί HTML ή άιιε έμνδν πνπ ζα δεη ν 

επηζθέπηεο.  

Η ΡΗΡ δεκηνπξγήζεθε ην 1994 θαη ήηαλ αξρηθά ε δνπιεηά ελφο αηφκνπ , ηνπ Rasmus  

Lerdorf. Τηνζεηήζεθε θαη απφ άιια ηαιαληνχρα άηνκα θαη έρεη πεξάζεη απφ ηξεηο 

βαζηθέο εθδφζεηο . Σνλ Ιαλνπάξην ηνπ 2001 ήηαλ ζε ρξήζε ζρεδφλ ζε πέληε 

εθαηνκκχξηα ηνκείο παγθφζκηα θαη απηφο ν αξηζκφο κεγαιψλεη γξήγνξα.  

Η ΡΗΡ είλαη έλα πξντφλ αλνηρηνχ θψδηθα. Θα έρεηε πξφζβαζε ζηνλ θψδηθα 

πξνέιεπζεο. Μπνξείηε λα ηνλ ρξεζηκνπνηήζεηε , λα ηνλ αιιάμεηε θαη λα ηνλ 

αλαδηαλείκεηε , ρσξίο ρξέσζε.  

Η ΡΗΡ αξρηθά ζήκαηλε Personal Home Page ( πξνζσπηθή αξρηθή ζειίδα ), αιιά 

άιιαμε ζχκθσλα κε ηελ ζχκβαζε GNU θαη ηψξα ζεκαίλεη PHP Hypertext  

Preprocessor ( πξνεπεμεξγαζηήο θεηκέλνπ PHP ).  

http://el.wikipedia.org/wiki/Oracle_Database
http://el.wikipedia.org/wiki/MySQL
http://el.wikipedia.org/wiki/%CE%A0%CE%B1%CE%B3%CE%BA%CF%8C%CF%83%CE%BC%CE%B9%CE%BF%CF%82_%CE%B9%CF%83%CF%84%CF%8C%CF%82
http://el.wikipedia.org/w/index.php?title=%CE%9Detscape_(%CE%B5%CF%84%CE%B1%CE%B9%CF%81%CE%B5%CE%AF%CE%B1)&action=edit&redlink=1
http://el.wikipedia.org/wiki/Unix
http://el.wikipedia.org/w/index.php?title=Microsoft_Internet_Information_Services&action=edit&redlink=1
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Η ηξέρνπζα βαζηθή έθδνζε ηεο ΡΗΡ είλαη ε 4. Απηή ε έθδνζε έρεη κεξηθέο κεγάιεο 

βειηηψζεηο ζηε γιψζζα. 

 

 

 

Πιενλεθηήκαηα ηεο ΡΗΡ 

 

Κάπνηνη απφ ηνπο βαζηθνχο αληαγσληζηέο ηεο ΡΗΡ είλαη ν Perl, Microsoft Active  

Server Pages (ASP) , Java Server Pages ( JSP ) θαη Allaire Cold Fusion .  

ε ζχγθξηζε κε απηά ηα πξντφληα, ε ΡΗΡ έρεη πνιιά πιενλεθηήκαηα φπσο :  

 

 

 

· Τςειή απφδνζε 

· Γηαζπλδέζεηο κε πνιιά δηαθνξεηηθά ζπζηήκαηα βάζεσλ δεδνκέλσλ 

· Δλζσκαησκέλεο βηβιηνζήθεο γηα πνιιέο ζπλεζηζκέλεο Web δηαδηθαζίεο 

· Υακειφ θφζηνο 

· Δπθνιία κάζεζεο θαη ρξήζεο 

· Μεηαθεξζηκφηεηα 

· Γηαζεζηκφηεηα ηνπ θψδηθα πξνέιεπζεο 

 

 

Αθνινπζεί κηα πην ιεπηνκεξή πεξηγξαθή απηψλ ησλ πιενλεθηεκάησλ.  

 

 Απόδνζε 

 

Η ΡΗΡ είλαη πνιχ απνηειεζκαηηθή. Με έλα θζελφ δηαθνκηζηή κπνξείηε λα 

εμππεξεηήζεηε εθαηνκκχξηα επηζθέςεσλ θαζεκεξηλά. Οη δνθηκέο πνπ δεκνζηεχζεθαλ 

απφ ηελ Zend Technologies ( http://www.zend.com), δείρλνπλ φηη ε ΡΗΡ μεπεξλά 

ηνπο αληαγσληζηέο ηεο.  

 

 

 Οινθιήξσζε κε Βάζεηο δεδνκέλσλ 

 

Η ΡΗΡ έρεη εγγελείο ζπλδέζεηο γηα πνιιά ζπζηήκαηα βάζεσλ δεδνκέλσλ. Δθηφο απφ 

ηελ MySQL , κπνξείηε λα ζπλδεζείηε θαηεπζείαλ κε ηηο βάζεηο δεδνκέλσλ  

PostgreSQL , mSQL , Oracle , dbm , filePro , Informix , InterBase , Sybase , κεηαμχ 

άιισλ.  

Υξεζηκνπνηψληαο ην Open Database Connectivity Standard (ODBC) κπνξείηε λα 

ζπλδεζείηε ζε νπνηαδήπνηε βάζε δεδνκέλσλ παξέρεη έλα πξφγξακκα νδήγεζεο 

ODBC . Απηφ πεξηιακβάλεη θαη ηα πξντφληα ηεο Microsoft products , κεηαμχ άιισλ .  

 

 

 Δλζσκαησκέλεο Βηβιηνζήθεο 

 

Δπεηδή ε ΡΗΡ ζρεδηάζηεθε γηα λα ρξεζηκνπνηείηαη ζην Web , έρεη πνιιέο 

ελζσκαησκέλεο βηβιηνζήθεο , πνπ εθηεινχλ πνιιέο ρξήζηκεο ιεηηνπξγίεο ζρεηηθέο κε 

ην Web . Μπνξείηε λα δεκηνπξγήζεηε εηθφλεο GIF δπλακηθά , λα ζπλδεζείηε κε άιιεο 

ππεξεζίεο δηθηχσλ , λα ζηείιεηε ειεθηξνληθφ ηαρπδξνκείν , λα δνπιέςεηε κε cookies  
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θαη λα δεκηνπξγήζεηε PDF έγγξαθα : φια απηά κε ιίγεο γξακκέο θψδηθα. Γεκηνπξγία δπλακηθήο 

ηζηνζειίδαο ζε PHP. Αλάπηπμε εθαξκνγήο FORUM.  

 

 

 Κόζηνο 

 

Η ΡΗΡ είλαη δσξεάλ . Μπνξείηε λα θαηεβάζεηε ηελ ηειεπηαία έθδνζε απφ ην 

http://www.php.net , ρσξίο ρξέσζε.  

 

 

 Δθκάζεζε ηεο ΡΗΡ 

 

Η ζχληαμε ηεο ΡΗΡ βαζίδεηαη ζε άιιεο γιψζζεο πξνγξακκαηηζκνχ ,βαζηθά ζηελ C  

θαη ζηελ Perl .  

 

 Μεηαθεξζηκόηεηα 

 

Η ΡΗΡ είλαη δηαζέζηκε γηα πνιιά ιεηηνπξγηθά ζπζηήκαηα . Μπνξείηε λα γξάςεηε 

θψδηθα ΡΗΡ γηα δσξεάλ ζπζηήκαηα ηχπνπ Unix , φπσο LINUX θαη FreeBSD , γηα 

εκπνξηθέο εθδψζεηο ηνπ UNIX , φπσο ην Solaris θαη ην IRIX ή γηα δηαθνξεηηθέο 

εθδψζεηο ησλ Microsoft Windows.  

Ο θψδηθα ζαο ζπλήζσο ζα δνπιεχεη ρσξίο αιιαγέο ζηα ζπζηήκαηα πνπ ηξέρνπλ ηελ 

ΡΗΡ.  

 

 Κώδηθαο πξνέιεπζεο 

 

Έρεηε πξφζβαζε ζηνλ θψδηθα πξνέιεπζεο ηεο ΡΗΡ. Αληίζεηα κε εκπνξηθά , θιεηζηά 

πξνγξάκκαηα , αλ ππάξρεη θάηη πνπ ζέιεηε λα αιιάμεηε ή λα πξνζζέζεηε ζηε 

γιψζζα, κπνξείηε λα ην θάλεηε.  

Γελ ρξεηάδεηαη λα πεξηκέλεηε ηνλ θαηαζθεπαζηή λα εκθαλίζεη δηνξζψζεηο. Γελ ζα 

αλεζπρείηε αλ ν θαηαζθεπαζηήο ζα ζηακαηήζεη λα ππάξρεη ή αλ ζα ζηακαηήζεη λα 

ππνζηεξίδεη ην πξντφλ. 

 

3.4 Perl 

 

 

10 perl logo 

Ση Δίλαη ε Perl 
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Σα αξρηθά PERL ζεκαίλνπλ Practical Extraction and Report Language. Η Perl είλαη κηα γιψζζα 

πξνγξακκαηηζκνχ πνπ αλαπηχρζεθε απφ ηνλ Larry Wall θαη ζρεδηάζηεθε εηδηθά γηα ηελ 

επεμεξγαζία θεηκέλνπ. Δμαηηίαο ησλ ηζρπξψλ δπλαηνηήησλ επεμεξγαζίαο θεηκέλνπ πνπ δηαζέηεη, 

ε Perl έρεη γίλεη κηα απφ ηηο πην δεκνθηιείο γιψζζεο γηα ην γξάςηκν ησλ CGI scripts. Η Perl είλαη 

κηα δηεξκελεπφκελε γιψζζα (interpretive language) πνπ ζεκαίλεη φηη κπνξνχκε εχθνια λα 

γξάςνπκε θαη λα δνθηκάζνπκε απιά πξνγξάκκαηα. 

Δίλαη δηαζέζηκε δσξεάλ ζην Web θαη ρξεζηκνπνηείηαη ζε πνιιέο εθαξκνγέο, φπσο ην λα 

γξάςνπκε CGI scripts πνπ βνεζνχλ ηνπο administrators ζηελ ζπληήξεζε ησλ ζπζηεκάησλ ηνπο. 

Η Perl δεκηνπξγήζεθε, θαη ζπληεξείηαη αθφκα, απφ ηνλ Larry Wall. Δίλαη πην αξγή απφ ηελ C, 

αιιά πην γξήγνξε απφ κηα θαλνληθή δηεξκελεπφκελε γιψζζα. 

Έλα απφ ηα πην σξαία πξάγκαηα ζρεηηθά κε ηελ Perl είλαη ην φηη δηαηίζεηαη δσξεάλ. Γηαλέκεηαη 

κε ηελ άδεηα GNU license θαη ν πεγαίνο θψδηθάο ηεο είλαη δηαζέζηκνο απφ ηελ αξρηθή ηζηνζειίδα 

ηεο Perl (Perl Home Page), ηελ http://www.perl.com. Απηφ, ζε ζπλδπαζκφ κε ην φηη είλαη 

επέιηθηε θαη έρεη πνιχ ιίγνπο πεξηνξηζκνχο, θάλνπλ ηελ Perl κηα δεκνθηιή γιψζζα. Αθφκα, 

ππνζηεξίδεηαη απφ πνιιέο πιαηθφξκεο φπσο Unix, Windows θαη DOS. 

 

Σα Πιενλεθηήκαηα ηεο Perl  

 Δίλαη απνδεθηή απφ πνιιέο πιαηθφξκεο, φπσο Unix, Windows θαη DOS. 

 Δίλαη εχθνιν λα γξάςνπκε ηζρπξά πξνγξάκκαηα κε ιίγεο γξακκέο θψδηθα. 

 Δίλαη θαιή γηα εξγαζίεο αλάιπζεο (data parsing) / εμαγσγήο (extraction) / θαη ρεηξηζκνχ 

(manipulation) δεδνκέλσλ. 

 Δίλαη κηα επέιηθηε γιψζζα. 

 

Σα Μεηνλεθηήκαηα ηεο Perl 

 Μεξηθέο θνξέο είλαη δχζθνιν λα δηαρεηξηζηνχκε κεγάια πξνγξάκκαηα ηεο Perl. 

 Μεξηθέο θνξέο είλαη επηθίλδπλα επέιηθηε γηα κηα γιψζζα πξνγξακκαηηζκνχ. 

 Μπνξεί λα είλαη πνιχ κπζηήξηα θαη πνιχ γξήγνξε. 

 

 

3.5 Javascript 

 

http://www.perl.com/
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11 javascript logo 

Η γιψζζα πξνγξακκαηηζκνχ JavaScript δεκηνπξγήζεθε αξρηθά απφ ηνλ Brendan Eich ηεο 

εηαηξείαο Netscape κε ηελ επσλπκία Mocha. Αξγφηεξα, Mocha κεηνλνκάζηεθε ζε LiveScript, 

θαη ηειηθά ζε JavaScript, θπξίσο επεηδή ε αλάπηπμή ηεο επεξεάζηεθε πεξηζζφηεξν απφ ηε 

γιψζζα πξνγξακκαηηζκνχ Java 

Η JavaScript έρεη γίλεη κία απφ ηηο πην δεκνθηιείο γιψζζεο πξνγξακκαηηζκνχ ειεθηξνληθψλ 

ππνινγηζηψλ ζηνλ Παγθφζκην Ιζηφ (Web). Αξρηθά, φκσο, πνιινί επαγγεικαηίεο 

πξνγξακκαηηζηέο ππνηίκεζαλ ηε γιψζζα δηφηη ην θνηλφ ηεο ήηαλ εξαζηηέρλεο ζπγγξαθείο 

ηζηνζειίδσλ θαη φρη επαγγεικαηίεο πξνγξακκαηηζηέο (θαη κεηαμχ άιισλ ιφγσλ). Με κε ηε ρξήζε 

ηεο ηερλνινγίαο Ajax, ε JavaScript γιψζζα επέζηξεςε ζην πξνζθήλην θαη έθεξε πην 

επαγγεικαηηθή πξνζνρή πξνγξακκαηηζκνχ. Σν απνηέιεζκα ήηαλ έλα θαηλνηφκν αληίθηππν ζηελ 

εμάπισζε ησλ πιαηζίσλ θαη ησλ βηβιηνζεθψλ, ηε βειηίσζε πξνγξακκαηηζκνχ κε JavaScript, 

θαζψο θαη απμεκέλε ρξήζε ηεο JavaScript έμσ απφ ηα πξνγξάκκαηα πεξηήγεζεο ζην Web. 

Σνλ Ιαλνπάξην ηνπ 2009, ην έξγν CommonJS ηδξχζεθε κε ζηφρν ηνλ θαζνξηζκφ ελφο θνηλνχ 

πξνηχπνπ βηβιηνζήθεο θπξίσο γηα ηελ αλάπηπμε ηεο JavaScript έμσ απφ ην πξφγξακκα 

πεξηήγεζεο θαη κέζα ζε άιιεο ηερλνινγίεο (π.ρ. server-side).  

Η JavaScript (JS) είλαη δηεξκελεπκέλε γιψζζα πξνγξακκαηηζκνχ γηα ειεθηξνληθνχο 

ππνινγηζηέο. Αξρηθά απνηέιεζε κέξνο ηεο πινπνίεζεο ησλ θπιινκεηξεηψλ Ιζηνχ, ψζηε ηα 

ζελάξηα απφ ηελ πιεπξά ηνπ πειάηε (client-side scripts) λα κπνξνχλ λα επηθνηλσλνχλ κε ηνλ 

ρξήζηε, λα αληαιιάζζνπλ δεδνκέλα αζχγρξνλα θαη λα αιιάδνπλ δπλακηθά ην πεξηερφκελν ηνπ 

εγγξάθνπ πνπ εκθαλίδεηαη.  

Η JavaScript είλαη κηα γιψζζα ζελαξίσλ πνπ βαζίδεηαη ζηα πξσηφηππα (prototype-based), 

είλαη δπλακηθή, κε αζζελείο ηχπνπο θαη έρεη ζπλαξηήζεηο σο αληηθείκελα πξψηεο ηάμεο. 

Η ζχληαμή ηεο είλαη επεξεαζκέλε απφ ηε C. Η JavaScript αληηγξάθεη πνιιά νλφκαηα θαη 

ζπκβάζεηο νλνκαηνδνζίαο απφ ηε Java, αιιά γεληθά νη δχν απηέο γιψζζεο δε ζρεηίδνληαη θαη 

έρνπλ πνιχ δηαθνξεηηθή ζεκαζηνινγία. Οη βαζηθέο αξρέο ζρεδηαζκνχ ηεο JavaScript 

πξνέξρνληαη απφ ηηο γιψζζεο πξνγξακκαηηζκνχ Self θαη Scheme. Δίλαη γιψζζα βαζηζκέλε ζε 

δηαθνξεηηθά πξνγξακκαηηζηηθά παξαδείγκαηα (multi-paradigm), 

ππνζηεξίδνληαο αληηθεηκελνζηξεθέο, πξνζηαθηηθφ θαη ζπλαξηεζηαθφ ζηπι πξνγξακκαηηζκνχ. 

Η JavaScript ρξεζηκνπνηείηαη θαη ζε εθαξκνγέο εθηφο ηζηνζειίδσλ — ηέηνηα παξαδείγκαηα είλαη 

ηα έγγξαθα PDF, νη εμεηδηθεπκέλνη θπιινκεηξεηέο (site-specific browsers) θαη νη κηθξέο 

http://el.wikipedia.org/wiki/%CE%94%CE%B9%CE%B5%CF%81%CE%BC%CE%B7%CE%BD%CE%AD%CE%B1%CF%82_(%CF%85%CF%80%CE%BF%CE%BB%CE%BF%CE%B3%CE%B9%CF%83%CF%84%CE%AD%CF%82)
http://el.wikipedia.org/wiki/%CE%93%CE%BB%CF%8E%CF%83%CF%83%CE%B1_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CE%BF%CF%8D
http://el.wikipedia.org/wiki/%CE%A6%CF%85%CE%BB%CE%BB%CE%BF%CE%BC%CE%B5%CF%84%CF%81%CE%B7%CF%84%CE%AE%CF%82
http://el.wikipedia.org/wiki/%CE%93%CF%81%CE%B1%CF%86%CE%B9%CE%BA%CE%AE_%CE%B4%CE%B9%CE%B5%CF%80%CE%B9%CF%86%CE%AC%CE%BD%CE%B5%CE%B9%CE%B1_%CF%87%CF%81%CE%AE%CF%83%CF%84%CE%B7
http://el.wikipedia.org/wiki/%CE%93%CF%81%CE%B1%CF%86%CE%B9%CE%BA%CE%AE_%CE%B4%CE%B9%CE%B5%CF%80%CE%B9%CF%86%CE%AC%CE%BD%CE%B5%CE%B9%CE%B1_%CF%87%CF%81%CE%AE%CF%83%CF%84%CE%B7
http://el.wikipedia.org/w/index.php?title=Ajax_(%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CF%8C%CF%82)&action=edit&redlink=1
http://el.wikipedia.org/w/index.php?title=Document_Object_Model&action=edit&redlink=1
http://el.wikipedia.org/w/index.php?title=Document_Object_Model&action=edit&redlink=1
http://el.wikipedia.org/w/index.php?title=%CE%94%CF%85%CE%BD%CE%B1%CE%BC%CE%B9%CE%BA%CE%AE_%CE%B3%CE%BB%CF%8E%CF%83%CF%83%CE%B1&action=edit&redlink=1
http://el.wikipedia.org/w/index.php?title=%CE%91%CF%83%CE%B8%CE%B5%CE%BD%CE%B5%CE%AF%CF%82_%CF%84%CF%8D%CF%80%CE%BF%CE%B9&action=edit&redlink=1
http://el.wikipedia.org/w/index.php?title=%CE%A3%CF%85%CE%BD%CE%B1%CF%81%CF%84%CE%AE%CF%83%CE%B5%CE%B9%CF%82_%CF%89%CF%82_%CE%B1%CE%BD%CF%84%CE%B9%CE%BA%CE%B5%CE%AF%CE%BC%CE%B5%CE%BD%CE%B1_%CF%80%CF%81%CF%8E%CF%84%CE%B7%CF%82_%CF%84%CE%AC%CE%BE%CE%B7%CF%82&action=edit&redlink=1
http://el.wikipedia.org/wiki/%CE%A3%CF%8D%CE%BD%CF%84%CE%B1%CE%BE%CE%B7_(%CE%B3%CE%BB%CF%8E%CF%83%CF%83%CE%B1_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CE%BF%CF%8D)
http://el.wikipedia.org/wiki/C_(%CE%B3%CE%BB%CF%8E%CF%83%CF%83%CE%B1_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CE%BF%CF%8D)
http://el.wikipedia.org/wiki/Java
http://el.wikipedia.org/wiki/%CE%A4%CF%85%CF%80%CE%B9%CE%BA%CE%AE_%CF%83%CE%B7%CE%BC%CE%B1%CF%83%CE%B9%CE%BF%CE%BB%CE%BF%CE%B3%CE%AF%CE%B1_%CF%84%CF%89%CE%BD_%CE%B3%CE%BB%CF%89%CF%83%CF%83%CF%8E%CE%BD_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CE%BF%CF%8D
http://el.wikipedia.org/w/index.php?title=Self_(%CE%B3%CE%BB%CF%8E%CF%83%CF%83%CE%B1_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CE%BF%CF%8D)&action=edit&redlink=1
http://el.wikipedia.org/wiki/Scheme
http://el.wikipedia.org/wiki/%CE%A0%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CF%84%CE%B9%CE%BA%CF%8C_%CF%80%CE%B1%CF%81%CE%AC%CE%B4%CE%B5%CE%B9%CE%B3%CE%BC%CE%B1
http://el.wikipedia.org/wiki/%CE%91%CE%BD%CF%84%CE%B9%CE%BA%CE%B5%CE%B9%CE%BC%CE%B5%CE%BD%CE%BF%CF%83%CF%84%CF%81%CE%B5%CF%86%CE%AE%CF%82_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CF%8C%CF%82
http://el.wikipedia.org/wiki/%CE%A0%CF%81%CE%BF%CF%83%CF%84%CE%B1%CE%BA%CF%84%CE%B9%CE%BA%CF%8C%CF%82_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CF%8C%CF%82
http://el.wikipedia.org/wiki/%CE%A3%CF%85%CE%BD%CE%B1%CF%81%CF%84%CE%B7%CF%83%CE%B9%CE%B1%CE%BA%CF%8C%CF%82_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CF%8C%CF%82
http://el.wikipedia.org/w/index.php?title=%CE%9B%CE%BF%CE%B3%CE%B9%CF%83%CE%BC%CE%B9%CE%BA%CF%8C_%CE%B5%CF%86%CE%B1%CF%81%CE%BC%CE%BF%CE%B3%CF%8E%CE%BD&action=edit&redlink=1
http://el.wikipedia.org/wiki/Portable_Document_Format
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εθαξκνγέο ηεο επηθάλεηαο εξγαζίαο (desktop widgets). Οη λεφηεξεο εηθνληθέο κεραλέο θαη 

πιαίζηα αλάπηπμεο γηα JavaScript (φπσο ην Node.js) έρνπλ επίζεο θάλεη ηε JavaScript πην 

δεκνθηιή γηα ηελ αλάπηπμε εθαξκνγψλ Ιζηνχ ζηελ πιεπξά ηνπ δηαθνκηζηή (server-side). 

 

 

3.6 SQL 

 

 

12 sql logo 

H SQL είλαη κία γιψζζα ππνινγηζηψλ ζηηο βάζεηο δεδνκέλσλ, πνπ ζρεδηάζηεθε γηα ηε 

δηαρείξηζε δεδνκέλσλ, ζε έλα ζχζηεκα δηαρείξηζεο ζρεζηαθψλ βάζεσλ δεδνκέλσλ (Relational 

Database Management System, RDBMS) θαη ε νπνία, αξρηθά, βαζίζηεθε ζηε ζρεζηαθή άιγεβξα.  

Η γιψζζα πεξηιακβάλεη δπλαηφηεηεο αλάθηεζεο θαη ελεκέξσζεο δεδνκέλσλ, δεκηνπξγίαο θαη 

ηξνπνπνίεζεο ζρεκάησλ θαη ζρεζηαθψλ πηλάθσλ, αιιά θαη ειέγρνπ πξφζβαζεο ζηα δεδνκέλα. Η 

SQL ήηαλ κία απφ ηηο πξψηεο γιψζζεο γηα ην ζρεζηαθφ κνληέιν ηνπ Edgar F. Codd, ζην 

ζεκαληηθφ άξζξν ηνπ ην 1970, θαη έγηλε ε πην επξέσο ρξεζηκνπνηνχκελε γιψζζα γηα ηηο 

ζρεζηαθέο βάζεηο δεδνκέλσλ 

Η γιψζζα SQL ππνδηαηξείηαη ζε δηάθνξα γισζζηθά ζηνηρεία, πνπ πεξηιακβάλνπλ 

Clauses, νη νπνίεο είλαη ζε κεξηθέο πεξηπηψζεηο πξναηξεηηθέο, αιιά απαξαίηεηα ζπζηαηηθά ησλ 

δειψζεσλ θαη εξσηήζεσλ. 

Expressions πνπ κπνξνχλ λα παξαγάγνπλ είηε ηηο θιηκαθσηέο ηηκέο είηε πίλαθεο πνπ 

απνηεινχληαη απφ ζηήιεο θαη ζεηξέο ζηνηρείσλ. 

Predicates πνπ δηεπθξηλίδνπλ ηνπο φξνπο πνπ κπνξνχλ λα αμηνινγεζνχλ ζαλ ζσζηφ ή ιάζνο. 

Queries πνπ αλαθηνχλ ηα ζηνηρεία βαζηζκέλεο ζε εηδηθά θξηηήξηα. 

Statements πνπ κπνξνχλ λα έρνπλ κηα επίδξαζε ζηα ζρήκαηα θαη ηα ζηνηρεία, ή πνπ κπνξνχλ λα 

ειέγμνπλ ηε ξνή ηνπ πξνγξάκκαηνο θαη ηηο ζπλδέζεηο απφ άιια πξνγξάκκαηα. 

Σν θελφ αγλνείηαη γεληθά ζηηο Statements θαη ηηο Queries SQL. Δλα θελφ είλαη φκσο απαξαίηεην 

γηα λα μερσξίδεη Statements νπσο θαη ζηελ θαλνληθή γξαθή θεηκέλσλ. 

http://el.wikipedia.org/wiki/%CE%95%CE%B9%CE%BA%CE%BF%CE%BD%CE%B9%CE%BA%CE%AE_%CE%BC%CE%B7%CF%87%CE%B1%CE%BD%CE%AE
http://el.wikipedia.org/wiki/Node.js
http://el.wikipedia.org/wiki/%CE%93%CE%BB%CF%8E%CF%83%CF%83%CE%B1_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CE%BF%CF%8D
http://el.wikipedia.org/wiki/%CE%92%CE%AC%CF%83%CE%B7_%CE%B4%CE%B5%CE%B4%CE%BF%CE%BC%CE%AD%CE%BD%CF%89%CE%BD
http://el.wikipedia.org/wiki/%CE%A3%CF%87%CE%B5%CF%83%CE%B9%CE%B1%CE%BA%CE%AE_%CE%B2%CE%AC%CF%83%CE%B7_%CE%B4%CE%B5%CE%B4%CE%BF%CE%BC%CE%AD%CE%BD%CF%89%CE%BD
http://el.wikipedia.org/w/index.php?title=%CE%A3%CF%87%CE%B5%CF%83%CE%B9%CE%B1%CE%BA%CE%AE_%CE%AC%CE%BB%CE%B3%CE%B5%CE%B2%CF%81%CE%B1&action=edit&redlink=1
http://el.wikipedia.org/w/index.php?title=%CE%A3%CF%87%CE%B5%CF%83%CE%B9%CE%B1%CE%BA%CF%8C_%CE%BC%CE%BF%CE%BD%CF%84%CE%AD%CE%BB%CE%BF&action=edit&redlink=1
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3.6.1 MySql 
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Η MySQL είλαη έλα πνιχ γξήγνξν θαη δπλαηφ , ζχζηεκα δηαρείξηζεο βάζεσλ 

δεδνκέλσλ. Μηα βάζε δεδνκέλσλ ζαο επηηξέπεη λα απνζεθεχεηε , λα αλαδεηάηε , λα 

ηαμηλνκείηε θαη λα αλαθαιείηε ηα δεδνκέλα απνηειεζκαηηθά . Ο MySQL δηαθνκηζηήο 

ειέγρεη ηελ πξφζβαζε ζηα δεδνκέλα ζαο , γηα λα κπνξνχλ λα δνπιεχνπλ πνιινί 

ρξήζηεο ηαπηφρξνλα , γηα λα παξέρεη γξήγνξε πξφζβαζε θαη λα δηαζθαιίδεη φηη κφλν 

πηζηνπνηεκέλνη ρξήζηεο κπνξνχλ λα έρνπλ πξφζβαζε. πλεπψο ε MySQL είλαη έλαο 

πνιπλεκαηηθφο δηαθνκηζηήο πνιιαπιψλ ρξεζηψλ. Υξεζηκνπνηεί ηελ SQL ( 

Structured Query Language ) ηελ ηππηθή γιψζζα εξσηεκάησλ γηα βάζεηο 

δεδνκέλσλ, παγθφζκηα . H MySQL είλαη δηαζέζηκε απφ ην 1996 αιιά ε ηζηνξίαο ηεο 

μεθηλά απφ ην 1979 . 

 

 

Πιενλεθηήκαηα ηεο MySQL 

 

Μεξηθνί απφ ηνπο θχξηνπο αληαγσληζηέο ηεο MySQL είλαη νη PostgreSQL , Microsoft  

SQL θαη Oracle.  

H MySQL έρεη πνιιά πιενλεθηήκαηα , φπσο ρακειφ θφζηνο , εχθνιε δηακφξθσζε 

θαη κάζεζε θαη ν θψδηθαο πξνέιεπζεο είλαη δηαζέζηκνο.  

 

 Απόδνζε 

 

Η MySQL είλαη ρσξίο ακθηβνιία γξήγνξε. Μπνξείηε λα δείηε ηελ ζειίδα δνθηκψλ 

http://web.mysql.com/benchmark.html . Πνιιέο απφ απηέο ηηο δνθηκέο δείρλνπλ φηη ε 

MySQL είλαη αξθεηά πην γξήγνξε απφ ηνλ αληαγσληζκφ. Γεκηνπξγία δπλακηθήο ηζηνζειίδαο ζε 

PHP. Αλάπηπμε εθαξκνγήο FORUM.  

 

 

 Χακειό θόζηνο 

 

Η MySQL είλαη δηαζέζηκε δσξεάλ , κε άδεηα αλνηθηνχ θψδηθα (Open Source) ή κε 

ρακειφ θφζηνο , αλ πάξεηε εκπνξηθή άδεηα, αλ απαηηείηαη απφ ηελ εθαξκνγή ζαο.  

 

 Δπθνιία Χξήζεο 
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Οη πεξηζζφηεξεο κνληέξλεο βάζεηο δεδνκέλσλ ρξεζηκνπνηνχλ SQL. Αλ έρεηε 

ρξεζηκνπνηήζεη έλα άιιν ζχζηεκα δηαρείξηζεο βάζεσλ δεδνκέλσλ δελ ζα έρεηε 

πξφβιεκα λα πξνζαξκνζηείηε ζε απηφ.  

 

 Μεηαθεξζηκόηεηα 

 

Η MySQL κπνξεί λα ρξεζηκνπνηεζεί ζε πνιιά δηαθνξεηηθά ζπζηήκαηα Unix φπσο 

επίζεο θαη ζηα Microsoft Windows .  

 

 Κώδηθαο Πξνέιεπζεο 

 

πσο θαη κε ηελ ΡΗΡ , κπνξείηε λα πάξεηε θαη λα ηξνπνπνηήζεηε ηνλ θψδηθα 

πξνέιεπζεο ηεο MySQL. 

 

3.7 CSS 
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Η CSS (Cascading Style Sheets-Γηαδνρηθά Φχιια ηπι) ή ( αιιεινπρία θχιισλ ζηχι ) είλαη 

κηα γιψζζα ππνινγηζηή πνπ αλήθεη ζηελ θαηεγνξία ησλ γισζζψλ θχιισλ ζηπι πνπ 

ρξεζηκνπνηείηαη γηα ηνλ έιεγρν ηεο εκθάληζεο ελφο εγγξάθνπ πνπ έρεη γξαθηεί κε κηα γιψζζα 

ζήκαλζεο. Υξεζηκνπνηείηαη δειαδή γηα ηνλ έιεγρν ηεο εκθάληζεο ελφο εγγξάθνπ πνπ γξάθηεθε 

ζηηο γιψζζεο HTML θαη XHTML, δειαδή γηα ηνλ έιεγρν ηεο εκθάληζεο κηαο ηζηνζειίδαο θαη 

γεληθφηεξα ελφο ηζηνηφπνπ. Η CSS είλαη κηα γιψζζα ππνινγηζηή πξννξηζκέλε λα αλαπηχζζεη 

ζηπιηζηηθά κηα ηζηνζειίδα δειαδή λα δηακνξθψλεη πεξηζζφηεξα ραξαθηεξηζηηθά, ρξψκκαηα, 

ζηνίρηζε θαη δίλεη πεξηζζφηεξεο δπλαηφηεηεο ζε ζρέζε κε ηελ html. Γηα κηα φκνξθε θαη 

θαινζρεδηαζκέλε ηζηνζειίδα ε ρξήζε ηεο CSS θξίλεηαη σο απαξαίηεηε. 

 

Πνηα πιενλεθηήκαηα έρεη ε CSS: 

 Πνιχ κεγαιχηεξε επειημία. Σν CSS θαηέζηεζε εθηθηέο κνξθνπνηήζεηο νη νπνίεο ήηαλ 

αδχλαηεο ή πνιχ δχζθνιεο κε ηελ θιαζζηθή HTML 

 Δπθνιφηεξε ζπληήξεζε ησλ ηζηνζειίδσλ. Η εκθάληζε ελφο νιφθιεξνπ site κπνξεί λα 

ειέγρεηαη απφ έλα κφλν εμσηεξηθφ αξρείν CSS έηζη, θάζε αιιαγή ζην ζηπι ηεο 

ηζηνζειίδαο κπνξεί λα γίλεηαη κε κηα κνλαδηθή αιιαγή ζε απηφ ην αξρείν, αληί γηα ηελ 

επεμεξγαζία πνιιψλ ζεκείσλ ζε θάζε ζειίδα πνπ ππάεδεη ζην site. 

http://el.wikipedia.org/wiki/%CE%9A%CE%B1%CF%84%CE%B7%CE%B3%CE%BF%CF%81%CE%AF%CE%B1:%CE%93%CE%BB%CF%8E%CF%83%CF%83%CE%B5%CF%82_%CF%85%CF%80%CE%BF%CE%BB%CE%BF%CE%B3%CE%B9%CF%83%CF%84%CE%AE
http://el.wikipedia.org/w/index.php?title=%CE%9A%CE%B1%CF%84%CE%B7%CE%B3%CE%BF%CF%81%CE%AF%CE%B1:%CE%93%CE%BB%CF%8E%CF%83%CF%83%CE%B5%CF%82_%CF%86%CF%8D%CE%BB%CE%BB%CF%89%CE%BD_%CF%83%CF%84%CF%85%CE%BB&action=edit&redlink=1
http://el.wikipedia.org/w/index.php?title=%CE%9A%CE%B1%CF%84%CE%B7%CE%B3%CE%BF%CF%81%CE%AF%CE%B1:%CE%93%CE%BB%CF%8E%CF%83%CF%83%CE%B5%CF%82_%CF%83%CE%AE%CE%BC%CE%B1%CE%BD%CF%83%CE%B7%CF%82&action=edit&redlink=1
http://el.wikipedia.org/w/index.php?title=%CE%9A%CE%B1%CF%84%CE%B7%CE%B3%CE%BF%CF%81%CE%AF%CE%B1:%CE%93%CE%BB%CF%8E%CF%83%CF%83%CE%B5%CF%82_%CF%83%CE%AE%CE%BC%CE%B1%CE%BD%CF%83%CE%B7%CF%82&action=edit&redlink=1
http://el.wikipedia.org/wiki/HTML
http://el.wikipedia.org/w/index.php?title=XHTML&action=edit&redlink=1
http://el.wikipedia.org/wiki/%CE%99%CF%83%CF%84%CE%BF%CF%83%CE%B5%CE%BB%CE%AF%CE%B4%CE%B1
http://el.wikipedia.org/wiki/%CE%99%CF%83%CF%84%CF%8C%CF%84%CE%BF%CF%80%CE%BF%CF%82
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 Μηθξφηεξν κέγεζνο αξρείνπ, δεδνκέλνπ φηη ν θαλφλαο κνξθνπνίεζεο γξάθεηαη κφλν κηα 

θνξά θαη φρη ζε θάζε ζεκείν πνπ εθαξκφδεηαη. 

 Καιχηεξν SEO (Search Engine Optimization). Οη κεραλέο αλαδήηεζεο δελ 

«κπεξδεχνληαη» αλάκεζα ζε πεξηερφκελν θαη ηε κνξθνπνίεζε ηνπ, αιιά έρνπλ 

πξφζβαζε ζην πεξηερφκελν ζθέην, νπφηε είλαη πνιχ επθνιφηεξν λα ην θαηαγξάςνπλ θαη 

λα ην αξρεηνζεηήζνπλ. 

 Γξεγνξφηεξεο ζειίδεο. ηαλ ρξεζηκνπνηνχκε εμσηεξηθφ αξρείν CSS, ν browser ηελ 

πξψηε θνξά πνπ ζα θνξηψζεη θάπνηα ζειίδα ηνπ site καο απφζεθεχεη ζηελ cache, νπφηε 

δελ ρξεηάδεηαη λα ην θαηεβάζεη θάζε θνξά πνπ θαηεβάδεη ν ρξήζηεο ηνπ θάπνηα άιιε 

ζειίδα ηνπ site καο. 

 
Ιδηόηεηεο πνπ αθνξνύλ κνξθνπνίεζε θεηκέλνπ  

color  

Αθνξά ην ρξψκα ηνπ θεηκέλνπ, αιιά αλ δελ νξηζηεί ρξψκα πεξηγξάκκαηνο (κέζσ ηεο ηδηφηεηαο 

border‐color), ν browser ρξεζηκνπνηεί απηφ πνπ νξίζηεθε ζηελ ηδηφηεηα color. Σα ρξψκαηα 

κπνξνχλ λα εηζαρζνχλ είηε ζε κνξθή RGB (πρ color: rgb(255,128,30);), είηε ζε κνξθή hex (πρ 

color: #ff801e;) είηε κε ηε κνξθή θάπνηνπ keyword (πρ color:orange;). 

font‐size 

  

Αθνξά ην κέγεζνο ηεο γξακκαηνζεηξάο. Οη ηηκέο πνπ δέρεηαη κπνξνχλ λα είλαη εθθξαζκέλεο ζε 

έλα κεγάιν πιήζνο κνλάδσλ κεγέζνπο, απφ ηηο νπνίεο νη πην επξέσο δηαδεδνκέλεο είλαη ηα pixels 

(πρ font-size: 12px;) θαη νη ζηηγκέο (πρ font-size:10pt). Πεξηζζφηεξεο πιεξνθνξίεο εδψ.  

 

font‐family 

  

Η ηδηφηεηα απηή καο επηηξέπεη λα νξίζνπκε έλα πιήζνο γξακκαηνζεηξψλ πνπ ζα 

ρξεζηκνπνηεζνχλ γηα ην θείκελν, θαηά ζεηξά πξνηίκεζεο. Οπζηαζηηθά κέζσ απηήο νξίδνπκε ηε 

γξακκαηνζεηξά ηνπ θεηκέλνπ, απιά καο επηηξέπεη λα νξίζνπκε θαη ελαιιαθηηθέο επηινγέο, ψζηε 

αλ ε γξακκαηνζεηξά πνπ νξίζακε δελ ππάξρεη ζηνλ ππνινγηζηή ηνπ ρξήζηε, λα κελ καο 

θαηαζηξέςεη ν browser ηελ εκθάληζε ηεο ζειίδαο επηιέγνληαο φπνηα απηφο λνκίδεη, απιά ηελ 

επφκελε επηινγή καο. Αλ θακία απφ φζεο γξακκαηνζεηξέο νξίζακε δελ ππάξρεη ζηνλ ππνινγηζηή 

ηνπ ρξήζηε, ηφηε ν browser επηιέγεη θάπνηα πνπ λα αλήθεη ζηε γεληθή νηθνγέλεηα 

γξακκαηνζεηξψλ (generic font‐family) πνπ ζα νξίζνπκε ζην ηέινο κε ην θαηάιιειν keyword. 

Σέηνηα keywords είλαη ηα εμήο:  

serif: Γξακκαηνζεηξέο κε «παηνχξεο» φπσο ε Georgia.  

sans‐serif: Γξακκαηνζεηξέο ρσξίο «παηνχξεο» φπσο ε Trebuchet MS.  

monospace: Γξακκαηνζεηξέο φπνπ ην θάζε γξάκκα θαηαιακβάλεη ίζν πιάηνο κε ηα ππφινηπα, 

φπσο ε Courier New.  

cursive: Καιιηγξαθηθέο γξακκαηνζεηξέο φπσο ε Monotype Corsiva  

fantasy: «Γηαθνζκεηηθέο» γξακκαηνζεηξέο.  

Οη ηειεπηαίεο 2 γεληθέο νηθνγέλεηεο γξακκαηνζεηξψλ ρξεζηκνπνηνχληαη πνιχ ζπάληα.  

Παξάδεηγκα ρξήζεο ηεο ηδηφηεηαο: font-family: Calibri, Trebuchet MS, Verdana, sans-serif;  
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font‐style  

 

ε αληίζεζε κε απηφ πνπ ζα πεξίκελε θαλείο απφ κηα ηδηφηεηα κε απηφ ην φλνκα, δειαδή ηελ 

εθαξκνγή πνιιψλ θαη δηαθφξσλ «εθέ» ζην θείκελν, ζηελ πξαγκαηηθφηεηα αθνξά κφλν ηελ 

πεξίπησζε φπνπ ην θείκελν ζα είλαη πλάγιο. Γηα άιια εθέ, ρξεζηκνπνηνχληαη άιιεο ηδηφηεηεο, νη 

νπνίεο ζα εμεηαζηνχλ παξαθάησ. Οη πηζαλέο ηηκέο ηεο είλαη normal, italic θαη oblique. Οη δχν 

ηειεπηαίεο ζπλήζσο θάλνπλ ην ίδην πξάγκα (θαη είλαη πξνηηκφηεξε ε ρξήζε ηεο italic κηαο θαη 

ππνζηεξίδεηαη θαη απφ Internet Explorer 3, ελψ ε ππνζηήξημε γηα ηελ oblique μεθηλά απφ Internet 

Explorer 4), ελψ είλαη πξνθαλήο ε ιεηηνπξγία ηεο ηηκήο normal.  

 

font‐weight 

  

Αθνξά ην «βάξνο» ηεο γξακκαηνζεηξάο θαη ζηελ πξάμε ρξεζηκνπνηείηαη γηα λα νξίζεη αλ ην 

θείκελν καο ζα είλαη έληνλν ή φρη, κηαο θαη νη πεξηζζφηεξεο γξακκαηνζεηξέο πνπ 

ρξεζηκνπνηνχληαη ζην web δηαηίζεληαη κφλν ζε δχν βάξε: Καλνληθφ θαη έληνλν, ζε αληίζεζε κε 

πην εμεηδηθεπκέλεο γξακκαηνζεηξέο πνπ ρξεζηκνπνηνχληαη απφ γξαθίζηεο, νη νπνίεο πνιιέο 

θνξέο δηαηίζεληαη ζε δηάθνξα βάξε. Οπφηε νη ηηκέο πνπ  

ζπλήζσο ρξεζηκνπνηνχληαη ζε απηή ηελ ηδηφηεηα είλαη νη normal θαη bold, ε ιεηηνπξγία ησλ 

νπνίσλ είλαη πξνθαλήο.  

 

text‐decoration 

  

Μαο επηηξέπεη λα εθαξκφζνπκε ζην θείκελν καο δηάθνξα εθέ, ζπκπεξηιακβαλφκελεο θαη ηεο 

ππνγξάκκηζεο. Οη ηηκέο πνπ δέρεηαη είλαη νη εμήο:  

none: Κακία δηαθφζκεζε  

underline: Τπνγξάκκηζε  

overline: Γξακκή πάλσ απφ ην θείκελν (νπζηαζηηθά ην αληίζεην ηεο ππνγξάκκηζεο)  

line‐through: Γηαγξάκκηζε  

blink: Κάλεη ην θείκελν λα αλαβνζβήλεη. Γελ πξέπεη λα ρξεζηκνπνηείηαη, παξά κφλν ζε 

εμαηξεηηθά ζπάληεο πεξηπηψζεηο, κηαο θαη ε εκπεηξία έρεη δείμεη φηη είλαη εμαηξεηηθά θνπξαζηηθφ 

γηα ηνλ αλαγλψζηε θαη αθαηξεί επαγγεικαηηθφηεηα απφ ην design ηεο ηζηνζειίδαο.  

Οη παξαπάλσ ηηκέο κπνξνχλ λα ρξεζηκνπνηεζνχλ θαη ζπλδπαζηηθά, φηαλ επηζπκνχκε λα 

εθαξκφζνπκε πάλσ απφ έλα ηέηνην εθέ ζην θείκελν καο. Παξαδείγκαηνο ράξηλ text-decoration: 

underline overline;  

 

text‐align 

  

Μαο επηηξέπεη λα θαζνξίζνπκε ηε ζηνίρηζε ηνπ θεηκέλνπ καο. πσο ζα πεξίκελε θαλείο, νη 

πηζαλέο ηηκέο είλαη left, center, right θαη justify.  

 

font  

 

Μαο επηηξέπεη λα θαζνξίζνπκε αξθεηέο ηδηφηεηεο θεηκέλνπ κε κηα κφλν ηδηφηεηα (ζπγθεθξηκέλα 

ηηο font‐size, font‐family, font‐weight θαη font‐style απφ φζεο αλαθέξζεθαλ παξαπάλσ, θαζψο 

θαη θάπνηεο άιιεο πνπ δελ αλαθέξζεθαλ). Αλ θάπνηα ηδηφηεηα δελ ζπκπεξηιεθζεί, ν browser ζα 

«ππνζέζεη» ηελ πξνεπηιεγκέλε ηηκή ηεο.  

Παξαδείγκαηα:  

font: 12px Calibri, Trebuchet MS, Verdana, sans-serif;  

font: italic bold 12px Calibri, Trebuchet MS, Verdana, sans-serif;  
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Πξνζνρή: Αλ δελ νξίζνπκε θάπνηα επηκέξνπο ηδηφηεηα φηαλ ρξεζηκνπνηνχκε ηελ ζπγθεληξσηηθή 

ηδηφηεηα font, ν browser «ππνζέηεη» ηελ πξνεπηιεγκέλε ηηκή γηα απηή, φρη φηη δελ νξίζηεθε. Απηφ 

ζεκαίλεη φηη αλ γξάςνπκε γηα παξάδεηγκα:  

font-weight:bold;  

font: 12px Calibri, Trebuchet MS, Verdana, sans-serif;  

ηφηε ην θείκελν καο δελ ζα είλαη έληνλν, κηαο θαη αθνχ δελ νξίζακε ζηε font θαη ηελ font‐weight, 

ηφηε ν browser «ππνζέηεη» ηελ πξνεπηιεγκέλε ηηκή γηα απηή ηελ ηδηφηεηα, ε νπνία είλαη ε 

normal, θαη κηαο θαη ε font βξίζθεηαη θάησ απφ ηελ font‐weight, έρεη κεγαιχηεξε πξνηεξαηφηεηα, 

νπφηε επηθξαηεί γηα ηε font‐weight ε ηηκή normal.  

 

Ιδηόηεηεο πνπ αθνξνύλ ην θόλην  

 

background‐color  

 

Υξεζηκνπνηείηαη γηα λα νξίζεη ρξψκα θφληνπ ζηα ζηνηρεία πνπ αθνξά ν επηινγέαο. Σν ρξψκα 

κπνξεί λα γξαθεί ζε νπνηαδήπνηε απφ ηηο κνξθέο πνπ πεξηγξάθεθαλ γηα ηελ ηδηφηεηα color.  

 

background‐image  

 

Υξεζηκνπνηείηαη γηα λα νξίζεη κηα εηθφλα θφληνπ. Η ηηκή πνπ δέρεηαη είλαη ηεο κνξθήο 

url(δηεχζπλζε_εηθφλαο), παξαδείγκαηνο ράξηλ background-image:url(http://www.e-

steki.gr/logo.gif);. Γεληθά φηαλ εηζάγνπκε κηα δηεχζπλζε URL σο ηηκή (ή ηκήκα ηηκήο) θάπνηαο 

ηδηφηεηαο CSS, πάληα ηε γξάθνπκε εληφο ησλ παξελζέζεσλ ηνπ url(). Φπζηθά κπνξνχκε λα 

εηζάγνπκε θαη ζρεηηθά URLs, πρ background-image:url(logo.gif);.  

 

background‐repeat  

 

Αθνξά ηνλ ηξφπν πνπ ζα επαλαιακβάλεηαη ε εηθφλα πνπ νξίζακε ζηελ παξαπάλσ ηδηφηεηα. Οη 

ηηκέο πνπ δέρεηαη είλαη:  

no‐repeat: Κακία επαλάιεςε  

repeat‐x: Η εηθφλα επαλαιακβάλεηαη ζηνλ νξηδφληην άμνλα  

repeat‐y: Η εηθφλα επαλαιακβάλεηαη ζηνλ θάζεην άμνλα  

repeat: Η εηθφλα επαλαιακβάλεηαη θαη νξηδφληηα θαη θάζεηα (ε ηηκή repeat είλαη θαη ε 

πξνεπηιεγκέλε ηηκή ηεο ηδηφηεηαο background‐repeat).  

 

background‐position  

 

Η ηδηφηεηα απηή καο επηηξέπεη λα νξίζνπκε ηε ζέζε πνπ ζα ηνπνζεηεζεί ε εηθφλα θφληνπ πνπ 

νξίζακε κε ηελ ηδηφηεηα background‐image ηφζν θάζεηα, φζν θαη νξηδφληηα. πλήζσο σο ηηκέο 

ηεο ρξεζηκνπνηνχκε θάπνηα keywords, ηα νπνία είλαη ηα εμήο:  

left, center, right φζνλ αθνξά ηελ νξηδφληηα ζέζε ηεο εηθφλαο  

top, center, bottom φζνλ αθνξά ηελ θάζεηε ζέζε ηεο εηθφλαο  

Σα παξαπάλσ κπνξνχκε λα ηα ρξεζηκνπνηήζνπκε θαη ζπλδπαζηηθά (θαη ζπλήζσο απηφ γίλεηαη), 

φπσο ζηα παξαθάησ παξαδείγκαηα:  

background-position: left bottom;  

background-position: top right;  

background-position: center top;  

ή κπνξνχκε λα νξίζνπκε ηελ ηνπνζέηεζε κφλν θαηά ηνλ έλα άμνλα (γηα ηνλ άιιν ππνηίζεηαη ε 

πξνεπηιεγκέλε ηηκή, ε νπνία είλαη ζπλήζσο top γηα ηνλ θάζεην άμνλα θαη left γηα ηνλ νξηδφληην), 

φπσο ζηα παξαθάησ παξαδείγκαηα:  
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background-position: left;  

background-position: bottom;  

Αληί γηα ηα παξαπάλσ keywords, κπνξνχκε λα νξίζνπκε ηε ζέζε ηεο εηθφλαο θφληνπ θαη 

αξηζκεηηθά, είηε κε πνζνζηφ ή κε θάπνηα κνλάδα κεγέζνπο, φπσο ζηα παξαθάησ παξαδείγκαηα:  

background-position: 10% 25%;  

background-position: 60px 100px;  

αλ ηέηνηεο ηηκέο ρξεζηκνπνηνχληαη πνιχ πην ζπάληα.  

H ηδηφηεηα απηή ρξεζηκνπνηείηαη ζπλήζσο φηαλ έρνπκε νξίζεη λα κελ επαλαιακβάλεηαη ε εηθφλα 

θφληνπ (κέζσ ηεο ηδηφηεηαο background‐repeat). Κάπνηνη browsers ππνζηεξίδνπλ ηε ρσξηζηή 

δήισζε ζέζεο ηεο εηθφλαο ζηνλ θάζεην θαη ηνλ νξηδφληην άμνλα, κέζσ δχν ηδηνηήησλ κε φλνκα 

background‐position‐x θαη background‐position‐y, αιιά θαιχηεξα λα απνθεχγεηαη ε ρξήζε 

απηψλ ησλ ηδηνηήησλ, κηαο θαη δελ ππνζηεξίδνληαη απφ φινπο ηνπο browsers.  

 

Background 

  

Η ηδηφηεηα απηή απνηειεί νπζηαζηηθά ζπληφκεπζε γηα λα νξίζνπκε κε κία κφλν ηδηφηεηα φιεο ηηο 

παξαπάλσ (φπσο είλαη ε ηδηφηεηα font γηα ηα ραξαθηεξηζηηθά θεηκέλνπ). Παξαδείγκαηα ρξήζεο:  

background: #CCCCCC url(background.gif) no-repeat top center;  

background: #CCCCCC url(background.gif);  

Πξνζνρή: Αλ δελ νξίζνπκε θάπνηα επηκέξνπο ηδηφηεηα φηαλ ρξεζηκνπνηνχκε ηελ ζπγθεληξσηηθή 

ηδηφηεηα background, ν browser «ππνζέηεη» ηελ πξνεπηιεγκέλε ηηκή γηα απηή, φρη φηη δελ 

νξίζηεθε. Απηφ ζεκαίλεη φηη αλ γξάςνπκε γηα παξάδεηγκα:  

background-image: url(background.gif);  

background: #CCCCCC no-repeat top center;  

ηφηε δελ ζα εκθαλίδεηαη θάπνηα εηθφλα θφληνπ, κηαο θαη αθνχ δελ νξίζακε ζηε background θαη 

ηελ background‐image, ηφηε ν browser «ππνζέηεη» ηελ πξνεπηιεγκέλε ηηκή γηα απηή ηελ 

ηδηφηεηα, ε νπνία είλαη ε none, θαη κηαο θαη ε background βξίζθεηαη θάησ απφ ηελ 

background‐image, έρεη κεγαιχηεξε πξνηεξαηφηεηα, νπφηε επηθξαηεί γηα ηε background‐image ε 

ηηκή none.  

 

Ιδηόηεηεο πνπ αθνξνύλ ην πεξίγξακκα 

 

 border‐color 

 

 Ρπζκίδεη ην ρξψκα πεξηγξάκκαηνο. Σν ρξψκα κπνξεί λα γξαθεί ζε νπνηαδήπνηε απφ ηηο κνξθέο 

πνπ πεξηγξάθεθαλ γηα ηελ ηδηφηεηα color. Αλ δελ νξηζηεί απηή ε ηδηφηεηα, ρξεζηκνπνηείηαη ην 

ρξψκα πνπ νξίζηεθε ζηελ ηδηφηεηα color.  

border‐width Ρπζκίδεη ην πάρνο ηνπ πεξηγξάκκαηνο ζε θάπνηα απφ ηηο κνλάδεο κέηξεζεο πνπ 

κπνξνχλ λα ρξεζηκνπνηεζνχλ ζην CSS, ζπλεζέζηεξα ζε pixels.  

Παξάδεηγκα: border‐width: 10px;  

 

border‐style  

 

Οξίδεη ην ζηπι ηνπ πεξηγξάκκαηνο. Οη ηηκέο πνπ ρξεζηκνπνηνχληαη ζπλήζσο γηα ηελ ηδηφηεηα 

απηή είλαη νη εμήο:  

solid: «πκπαγέο» πεξίγξακκα, δειαδή ρσξίο θάπνηα δηαθφζκεζε, κηα εληαία γξακκή.  

dashed: Πεξίγξακκα πνπ απνηειείηαη απφ παχιεο.  

dotted: Πεξίγξακκα πνπ απνηειείηαη απφ ηειείεο. Αμίδεη λα ζεκεησζεί φηη ηα απνηειέζκαηα ηεο 

ρξήζεο ηεο ηηκήο απηήο δηαθέξνπλ ειαθξψο αλά ηνπο browsers. Γηα παξάδεηγκα ν Internet 
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Explorer εκθαλίδεη ηα dotted πεξηγξάκκαηα σο απνηεινχκελα απφ κηθξνχο θχθινπο, ελψ ν 

Mozilla Firefox ηα εκθαλίδεη σο απνηεινχκελα απφ κηθξά ηεηξάγσλα.  

double: αλ ηελ ηηκή solid, κφλν πνπ δεκηνπξγεί δχν πεξηγξάκκαηα, ε απφζηαζε θαη ην πάρνο 

ησλ νπνίσλ δελ κπνξνχλ λα ξπζκηζηνχλ ρσξηζηά αιιά ξπζκίδνληαη απηφκαηα ψζηε ην πάρνο 

ηνπο λα είλαη ζπλνιηθά φζν ε ηηκή πνπ νξίζακε ζηελ ηδηφηεηα border‐width. πλήζσο 

ρξεζηκνπνηείηαη ζε ζπλδπαζκφ κε πάρνο πεξηγξάκκαηνο 3px, γηα ην νπνίν δίλεη έλα αξθεηά 

θαιαίζζεην απνηέιεζκα.  

Τπάξρνπλ θαη νη ηηκέο groove, ridge, inset, outset νη νπνίεο δεκηνπξγνχλ δηαθφξσλ εηδψλ 

«ςεπδφ‐3D» πεξηγξάκκαηα, νη νπνίεο θαιχηεξα λα απνθεχγνληαη γηα ιφγνπο αηζζεηηθήο.  

 

 

 

border  

 

Η ηδηφηεηα απηή απνηειεί νπζηαζηηθά ζπληφκεπζε γηα λα νξίζνπκε κε κία κφλν ηδηφηεηα φιεο ηηο 

παξαπάλσ (φπσο είλαη ε ηδηφηεηα font γηα ηα ραξαθηεξηζηηθά θεηκέλνπ). Παξαδείγκαηα ρξήζεο:  

border: 10px solid #999999;  

border: 2px dashed;  

Πξνζνρή: Αλ δελ νξίζνπκε θάπνηα επηκέξνπο ηδηφηεηα φηαλ ρξεζηκνπνηνχκε ηελ ζπγθεληξσηηθή 

ηδηφηεηα border, ν browser «ππνζέηεη» ηελ πξνεπηιεγκέλε ηηκή γηα απηή, φρη φηη δελ νξίζηεθε. 

Απηφ ζεκαίλεη φηη αλ γξάςνπκε γηα παξάδεηγκα:  

border-color: orange;  

border: 2px dashed;  

ηφηε ην πεξίγξακκα καο δελ ζα είλαη πνξηνθαιί, ηνπιάρηζηνλ φρη ζε φινπο ηνπο browsers (εθηφο 

αλ είλαη πνξηνθαιί θαη ε ηδηφηεηα color), κηαο θαη αθνχ δελ νξίζακε ζηε border θαη ηελ 

border‐color, ηφηε ν browser «ππνζέηεη» ηελ πξνεπηιεγκέλε ηηκή γηα απηή ηελ ηδηφηεηα, θαη κηαο 

θαη ε border βξίζθεηαη θάησ απφ ηελ border‐color, έρεη κεγαιχηεξε πξνηεξαηφηεηα, νπφηε 

επηθξαηεί γηα ηε border‐color ε πξνεπηιεγκέλε ηηκή.  

Ση θάλνπκε αλ ζέινπκε λα νξίζνπκε δηαθνξεηηθφ πάρνο/ρξψκα/ζηχι πεξηγξάκκαηνο γηα ην 

πάλσ/δεμί/θάησ/αξηζηεξφ πεξίγξακκα;  

Κάζε κηα απφ ηηο ηδηφηεηεο πνπ αλαθέξζεθαλ παξαπάλσ, απνηειείηαη απφ ηέζζεξηο επηκέξνπο 

ηδηφηεηεο, νη νπνίεο καο επηηξέπνπλ λα νξίζνπκε δηαθνξεηηθέο ηηκέο γηα ηελ ηδηφηεηα απηή φζνλ 

αθνξά ην πάλσ/δεμί/θάησ/αξηζηεξφ πεξίγξακκα. Κάζε ηδηφηεηα ηεο κνξθήο border‐θάηη 

αληηζηνηρεί ζε ηέζζεξηο ηδηφηεηεο ηεο κνξθήο border‐top‐θάηη, border‐right‐θάηη, 

border‐bottom‐θάηη, border‐left‐θάηη. Δπίζεο, θάζε ηδηφηεηα απφ απηέο πνπ αλαθέξζεθαλ 

παξαπάλσ δέρεηαη θαη ηηκέο ηεο κνξθήο [top] [right] [bottom] [left] (έλαο εχθνινο κλεκνληθφο 

θαλφλαο γηα ηε ζεηξά ησλ ηηκψλ είλαη φηη ε ζεηξά απηή είλαη ζχκθσλε κε ηελ πνξεία ησλ δεηθηψλ 

ηνπ ξνινγηνχ) ή ηεο κνξθήο [top,bottom] [right,left] αληί γηα κφλν κηα ηηκή πνπ ζα εθαξκνζηεί 

θαη γηα ηηο ηέζζεξηο πιεπξέο ηνπ πεξηγξάκκαηνο.  

 

 

Γηάθνξεο ρξήζηκεο ηδηόηεηεο  

 

padding  

 

Οξίδεη ην θελφ πνπ ζα ππάξρεη κεηαμχ ησλ νξίσλ ελφο ζηνηρείνπ θαη ησλ πεξηερνκέλσλ ηνπ. Δίλαη 

πνιχ ζεκαληηθφ λα νξίδνπκε padding ζε ζηνηρεία ζηα νπνία έρνπκε νξίζεη θάπνην πεξίγξακκα, 

ψζηε λα κελ «θνιιάλε» ηα πεξηερφκελα ηνπο κε ην πεξίγξακκα, θάηη πνπ θαίλεηαη ηδηαίηεξα 

άζρεκν θαη εξαζηηερληθφ. Δπίζεο, θαιφ είλαη λα κελ είζηε ηδηαίηεξα θεηδσινί κε ην padding. 
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Πεξηζζφηεξν padding δίλεη πην επαγγεικαηηθή εκθάληζε (κέρξη θάπνησλ νξίσλ θπζηθά). Γηα λα 

νξίζνπκε δηαθνξεηηθφ padding αλά πιεπξά, κπνξνχκε νκνίσο κε ην border, είηε λα 

ρξεζηκνπνηήζνπκε ηηο ηδηφηεηεο padding‐top, padding‐right, padding‐bottom, padding‐left, είηε 

λα εηζάγνπκε θαη ηηο ηέζζεξηο ηηκέο ζηελ ηδηφηεηα padding κε ηε ζεηξά [top] [right] [bottom] 

[left], είηε [top,bottom] [right,left]. Παξαδείγκαηα:  

padding: 8px;  

padding: 2px 6px;  

padding: 0px 6px 6px 6px;  

 

margin  

 

Σν αληίζεην νπζηαζηηθά ηνπ padding. Οξίδεη ηνλ ρψξν κεηαμχ ησλ νξίσλ ελφο ζηνηρείνπ θαη 

φζσλ ην πεξηβάιινπλ. Δίλαη ηδηαίηεξα ζεκαληηθφ λα νξίδνπκε margin ζε εηθφλεο, ψζηε λα έρνπλ 

απφζηαζε απφ ηα πεξηερφκελα ηνπο, κηαο θαη είλαη ηδηαίηεξα αληηαηζζεηηθφ λα «θνιιάλε» κε ην 

θείκελν. Φπζηθά θαη εδψ κπνξνχκε λα ρξεζηκνπνηήζνπκε είηε ηηο ηδηφηεηεο margin‐top, 

margin‐right, margin‐bottom, margin‐left γηα λα νξίζνπκε δηαθνξεηηθέο ηηκέο margin αλά 

πιεπξά, είηε λα εηζάγνπκε ηηο ηέζζεξηο δηαθνξεηηθέο ηηκέο margin κε ηε ζεηξά [top] [right] 

[bottom] [left], ή [top,bottom] [right,left]. Παξαδείγκαηα:  

margin: 4px;  

margin: 2px 4px;  

margin: 0px 8px 2px 2px;  

width, height  

πσο είλαη πξνθαλέο, νη δχν απηέο ηδηφηεηεο νξίδνπλ ην πιάηνο θαη ην χςνο ελφο ζηνηρείνπ, είηε 

ζε πνζνζηφ (ην νπνίν ππνινγίδεηαη βάζεη ηνπ ζηνηρείνπ πνπ ην πεξηέρεη), είηε ζε θάπνηα κνλάδα 

κήθνπο. Παξαδείγκαηα:  

width: 100px;  

width: 90%;  

height: 300px;  

height: 100%;  

Τπάξρνπλ θαη νη ηδηφηεηεο min‐width, min‐height, max‐width, max‐height νη νπνίεο νξίδνπλ ηα 

φξηα ζηα νπνία κπνξνχλ λα θηλνχληαη νη δηαζηάζεηο ελφο ζηνηρείνπ, φηαλ δελ ζέινπκε λα 

νξίζνπκε ζπγθεθξηκέλεο δηαζηάζεηο, αιιά θαιφ είλαη λα κελ ρξεζηκνπνηνχληαη αθφκα, φζν 

βνιηθέο θη αλ θαίλνληαη, κηαο θαη δπζηπρψο ε ππνζηήξημε ηνπο απφ ηνπο ππάξρνληεο browsers 

είλαη πεξηνξηζκέλε.  

 

float  

 

H ηδηφηεηα απηή είλαη αλεθηίκεηεο ρξεζηκφηεηαο ζην φηαλ ρξεζηκνπνηνχκε CSS θαη γηα ην 

layout ηεο ζειίδαο καο, αλ θαη είλαη ε δπζθνιφηεξε ζηελ θαηαλφεζε απφ φζεο αλαθέξζεθαλ. 

Γέρεηαη ηηο ηηκέο right, left θαη none θαη επηηξέπεη ηα ζηνηρεία πνπ πεξηβάιινπλ ην ζηνηρείν 

εθείλν ζην νπνίν εθαξκφδνπκε ηελ ηδηφηεηα απηή λα «ξένπλ» ηξηγχξσ ηνπ. Μηα ζπλεζηζκέλε 

ρξήζε ηεο ηδηφηεηαο είλαη ζηηο εηθφλεο πνπ ζπλνδεχνπλ έλα άξζξν. Πνιιέο θνξέο 

ρξεζηκνπνηνχκε κεηά απφ floated ζηνηρεία θάπνην ζηνηρείν (ζπλήζσο έλα άδεην div) κε ηελ 

ηδηφηεηα clear: both; γηα λα «θαζαξίζεη» ηα floats γηα ην κεηέπεηηα πεξηερφκελν.  
 

 

 



Πτυχιακή εργαςία τμήματοσ Μηχανικϊν Πληροφορικήσ 

 

 

36 

3.8 joomla 

 

Σν joomla είλαη κία πιαηθφξκα –ειεχζεξε πξνο ρξήζε- αλνηρηνχ θψδηθα γηα ειεθηξνληθφ 

εκπφξην. Σν opencart παξέρεη κία επαγγεικαηηθή θαη αμηφπηζηε δνκή γηα ηελ θαηαζθεπή ελφο 

επηηπρεκέλνπ ειεθηξνηθνχ θαηαζηήκαηνο. Η δνκή απηή απεπζχλεηαη ζε δηαθνξεηηθνχ ηχπνπ 

ρξήζηεο, απφ απαηηεηηθνχο ζρεδηαζηέο ηζηνζειίδσλ πνπ ςάρλνπλ έλα επθνιφρξεζην πεξηβάιινλ 

γηα λα πξνγξακκαηίζνπλ, κέρξη ηνπο ηδηνθηήηεο ηνπ θαηαζηήκαηνο πνπ απιά ζέινπλ λα εηζάγνπλ 

ηελ επηρείξεζε ηνπο ζηνλ ηνκέα ηνπ ειεθηξνληθνχ εκπνξίνπ. Σν joomla ερεη πιεζψξα επηινγψλ 

θαη ραξαθηεξηζηηθψλ πνπ κπνξνχλ λα βνεζήζνπλ ζηελ παξακεηξνπνίεζε ηνπ ειεθηξνληθνχ 

θαηαζηήκαηνο. 

3.9 Html 

 

 
15 html 

 

Η HTML (αθξσλχκην ηνπ αγγιηθνχ HyperText Markup Language, ειι. Γιψζζα ήκαλζεο 

Τπεξθεηκέλνπ) είλαη ε θχξηα γιψζζα ζήκαλζεο γηα ηηο ηζηνζειίδεο, θαη ηα ζηνηρεία ηεο είλαη ηα 

βαζηθά δνκηθά ζηνηρεία ησλ ηζηνζειίδσλ. 

 

Η HTML γξάθεηαη ππφ κνξθή ζηνηρείσλ HTML ηα νπνία απνηεινχληαη απφ εηηθέηεο (tags), νη 

νπνίεο πεξηθιείνληαη κέζα ζε ζχκβνια «κεγαιχηεξν απφ» θαη «κηθξφηεξν απφ» (γηα παξάδεηγκα 

<html>), κέζα ζην πεξηερφκελν ηεο ηζηνζειίδαο. Οη εηηθέηεο HTML ζπλήζσο ιεηηνπξγνχλ αλά 

δεχγε (γηα παξάδεηγκα <h1> θαη </h1>), κε ηελ πξψηε λα νλνκάδεηαη εηηθέηα έλαξμεο θαη ηε 

δεχηεξε εηηθέηα ιήμεο (ή ζε άιιεο πεξηπηψζεηο εηηθέηα αλνίγκαηνο θαη εηηθέηα θιεηζίκαηνο 

αληίζηνηρα). Αλάκεζα ζηηο εηηθέηεο, νη ζρεδηαζηέο ηζηνζειίδσλ κπνξνχλ λα ηνπνζεηήζνπλ 

θείκελν, πίλαθεο, εηθφλεο θιπ. 

 

Ο ζθνπφο ελφο web browser είλαη λα δηαβάδεη ηα έγγξαθα HTML θαη ηα ζπλζέηεη ζε ζειίδεο πνπ 

κπνξεί θαλείο λα δηαβάζεη ή λα αθνχζεη. Ο browser δελ εκθαλίδεη ηηο εηηθέηεο HTML, αιιά ηηο 

ρξεζηκνπνηεί γηα λα εξκελεχζεη ην πεξηερφκελν ηεο ζειίδαο. 
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Σα ζηνηρεία ηεο HTML ρξεζηκνπνηνχληαη γηα λα θηίζνπλ φινπο ηνπ ηζηφηνπνπο. Η HTML 

επηηξέπεη ηελ ελζσκάησζε εηθφλσλ θαη άιισλ αληηθεηκέλσλ κέζα ζηε ζειίδα, θαη κπνξεί λα 

ρξεζηκνπνηεζεί γηα λα εκθαλίζεη δηαδξαζηηθέο θφξκεο. Παξέρεη ηηο κεζφδνπο δεκηνπξγίαο 

δνκεκέλσλ εγγξάθσλ (δειαδή εγγξάθσλ πνπ απνηεινχληαη απφ ην πεξηερφκελν πνπ κεηαθέξνπλ 

θαη απφ ηνλ θψδηθα κνξθνπνίεζεο ηνπ πεξηερνκέλνπ) θαζνξίδνληαο δνκηθά ζεκαληηθά ζηνηρεία 

γηα ην θείκελν, φπσο θεθαιίδεο, παξαγξάθνπο, ιίζηεο, ζπλδέζκνπο, παξαζέζεηο θαη άιια. 

Μπνξνχλ επίζεο λα ελζσκαηψλνληαη ζελάξηα εληνιψλ ζε γιψζζεο φπσο ε JavaScript, ηα νπνία 

επεξεάδνπλ ηε ζπκπεξηθνξά ησλ ηζηνζειίδσλ HTML. 

 

Οη Web browsers κπνξνχλ επίζεο λα αλαθέξνληαη ζε ζηπι κνξθνπνίεζεο CSS γηα λα νξίδνπλ 

ηελ εκθάληζε θαη ηε δηάηαμε ηνπ θεηκέλνπ θαη ηνπ ππφινηπνπ πιηθνχ. Ο νξγαληζκφο W3C, ν 

νπνίνο δεκηνπξγεί θαη ζπληεξεί ηα πξφηππα γηα ηελ HTML θαη ηα CSS, ελζαξξχλεη ηε ρξήζε ησλ 

CSS αληί δηαθφξσλ ζηνηρείσλ ηεο HTML γηα ζθνπνχο παξνπζίαζεο ηνπ πεξηερνκέλνπ 

 

3.9.1 ήκαλζε 

 

Η ζήκαλζε HTML απνηειείηαη απφ κεξηθά βαζηθά ζπζηαηηθά, ζπκπεξηιακβαλνκέλσλ 

ησλ ζηνηρείσλ (θαη ησλ ηδηνηήησλ ηνπο), ηνπο βαζηζκέλνπο ζε ραξαθηήξεο ηχπνπο δεδνκέλσλ, 

ηηο αλαθνξέο ραξαθηήξσλ θαη ηηο αλαθνξέο νληνηήησλ. Έλα μερσξηζηφ ζεκαληηθφ ζπζηαηηθφ 

είλαη ε δήισζε ηχπνπ εγγξάθνπ (document type declaration), ε νπνία νξίδεη ζηνλ browser ηνλ 

ηξφπν εκθάληζεο ηεο ζειίδαο. 

ηελ HTML, ην πξφγξακκα Hello world, έλα ζπλεζηζκέλν πξφγξακκα ππνινγηζηή πνπ 

ρξεζηκεχεη γηα ηε ζχγθξηζε γισζζψλ πξνγξακκαηηζκνχ, γισζζψλ ζελαξίσλ θαη γισζζψλ 

ζήκαλζεο, θηηάρλεηαη κε 9 γξακκέο θψδηθα, παξφηη νη λέεο γξακκέο είλαη πξναηξεηηθέο ζηεο 

HTML: 

 

<!DOCTYPE html> 

<html> 

  <head> 

    <title>Hello HTML</title> 

  </head> 

  <body> 

    <p>Hello world</p> 

  </body> 

</html> 

 

(Σν θείκελν αλάκεζα ζην <html> θαη ην </html> πεξηγξάθεη ηελ ηζηνζειίδα, θαη ην θείκελν 

κεηαμχ ηνπ <body> θαη ηνπ </body> είλαη ην νξαηφ κέξνο ηεο. Σν ζεκαζκέλν θείκελν 

'<title>Hello HTML</title>' θαζνξίδεη ηνλ ηίηιν πνπ ζα εκθαλίδεηαη ζηελ κπάξα ηίηινπ ηνπ 

browser.) 

3.9.2 ηνηρεία 

 

Σα έγγξαθα HTML απνηεινχληαη απφ ζηνηρεία HTML ηα νπνία ζηελ πην γεληθή κνξθή ηνπο 

έρνπλ ηξία ζπζηαηηθά: έλα δεχγνο απφ εηηθέηεο, ηελ «εηηθέηα εθθίλεζεο» θαη ηελ «εηηθέηα 

http://el.wikipedia.org/w/index.php?title=Document_type_declaration&action=edit&redlink=1
http://el.wikipedia.org/w/index.php?title=Hello_world&action=edit&redlink=1
http://el.wikipedia.org/wiki/%CE%A0%CF%81%CF%8C%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1_%CF%85%CF%80%CE%BF%CE%BB%CE%BF%CE%B3%CE%B9%CF%83%CF%84%CE%AE
http://el.wikipedia.org/wiki/%CE%93%CE%BB%CF%8E%CF%83%CF%83%CE%B1_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CE%BF%CF%8D
http://el.wikipedia.org/wiki/%CE%93%CE%BB%CF%8E%CF%83%CF%83%CE%B1_%CF%80%CF%81%CE%BF%CE%B3%CF%81%CE%B1%CE%BC%CE%BC%CE%B1%CF%84%CE%B9%CF%83%CE%BC%CE%BF%CF%8D_%CF%83%CE%B5%CE%BD%CE%B1%CF%81%CE%AF%CF%89%CE%BD
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ηεξκαηηζκνχ», κεξηθέο ηδηφηεηεο κέζα ζηελ εηηθέηα εθθίλεζεο, θαη ηέινο ην θείκελν ή ην 

γξαθηθφ πεξηερφκελν κεηαμχ ησλ εηηθεηψλ, ην νπνίν κπνξεί λα πεξηιακβάλεη θαη άιια ζηνηρεία 

εκθσιεπκέλα κέζα ηνπ. Σν ζηνηρείν HTML κπνξεί λα είλαη νηηδήπνηε αλάκεζα ζηηο εηηθέηεο 

εθθίλεζεο θαη ηεξκαηηζκνχ. Σέινο, θάζε εηηθέηα πεξηθιείεηαη ζε ζχκβνια «κεγαιχηεξν απφ» θαη 

«κηθξφηεξν απφ», δειαδή < θαη >. 

Δπνκέλσο, ε γεληθή κνξθή ελφο ζηνηρείνπ HTML είλαη: 

 <tag attribute1="value1" attribute2="value2">content</tag> . 

 Μεξηθά ζηνηρεία HTML πεξηγξάθνληαη σο άδεια ζηοιχεία, έρνπλ ηε κνξθή 

 <tag attribute1="value1" attribute2="value2" > , θαη δελ έρνπλ θαζφινπ πεξηερφκελν. Σν φλνκα 

θάζε ζηνηρείνπ HTML είλαη ην ίδην φλνκα πνπ ρξεζηκνπνηείηαη ζηηο αληίζηνηρεο εηηθέηεο. Σν 

φλνκα ηεο εηηθέηαο ηεξκαηηζκνχ μεθηλά κε κηα θάζεην «/», ε νπνία παξαιείπεηαη ζηα άδεηα 

ζηνηρεία. Σέινο, αλ δελ αλαθέξνληαη ξεηά νη ηδηφηεηεο ελφο ζηνηρείνπ, ηφηε ρξεζηκνπνηνχληαη νη 

πξνεπηινγέο ζε θάζε πεξίπησζε. 

 

Παξαδείγκαηα ζηνηρείσλ: 

 

Κεθαιίδα ηνπ εγγξάθνπ HTML: <head>...</head>. 

 πλήζσο πεξηέρεη ηνλ ηίηιν, π.ρ: 

 

<head> 

  <title>The title</title> 

</head> 

 

Δπηθεθαιίδεο:  
νη επηθεθαιίδεο ζηελ HTML νξίδνληαη κε ηηο εηηθέηεο <h1> έσο <h6>: 

<h1>Δπηθεθαιίδα1</h1> 

<h2>Δπηθεθαιίδα2</h2> 

<h3>Δπηθεθαιίδα3</h3> 

<h4>Δπηθεθαιίδα4</h4> 

<h5>Δπηθεθαιίδα5</h5> 

<h6>Δπηθεθαιίδα6</h6> 

 

Παξάγξαθνη: 

<p>Paragraph 1</p>  <p>Paragraph 2</p> 

 

Αιιαγή γξακκήο: <br>. Η δηαθνξά αλάκεζα ζην <br> θαη ην <p> είλαη φηη ην «br» αιιάδεη 

γξακκή ρσξίο λα αιιάδεη ηελ ζεκαληηθή δνκή ηεο ζειίδαο, ελψ ην «p» ηεκαρίδεη ηε ζειίδα ζε 

παξαγξάθνπο. Σν «br» είλαη έλα άδεην ζηνηρείν, δειαδή δελ έρεη πεξηερφκελν, νχηε θαη 

ρξεηάδεηαη εηηθέηα ηεξκαηηζκνχ. 

<p>This <br> is a paragraph <br> with <br> line breaks</p> 

 

ρόιηα: 

<!-- This is a comment --> 

Σα ζρφιηα κπνξνχλ λα βνεζήζνπλ ζηελ θαηαλφεζε ηεο ζήκαλζεο. Γελ εκθαλίδνληαη ζηελ 

ηζηνζειίδα. 

 

Τπάξρνπλ δηάθνξνη ηχπνπ ζηνηρείσλ ζηελ HTML. 
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Η δνκηθή ζήκαλζε πεξηγξάθεη ηνλ ζθνπό ηνπ θεηκέλνπ 

Γηα παξάδεηγκα, ην <h2>Golf</h2>  ζεκαίλεη φηη ε ιέμε «Golf» ζα είλαη κηα επηθεθαιίδα 

δεχηεξνπ επηπέδνπ. Η δνκηθή ζήκαλζε δελ εκπεξηέρεη ζπγθεθξηκέλν ηξφπν εκθάληζεο, αιιά νη 

πεξηζζφηεξνη browser έρνπλ δηθφ ηνπο πξνθαζνξηζκέλν ηξφπν γηα ηε κνξθνπνίεζε φισλ ησλ 

ζηνηρείσλ. Σν πεξηερφκελν κπνξεί λα κνξθνπνηεζεί νπηηθά κε ηε ρξήζε ησλ CSS. 

 

Η ζήκαλζε νπηηθήο κνξθνπνίεζεο πεξηγξάθεη ηελ εκθάληζε ηνπ θεηκέλνπ, άζρεηα από ηνλ 

ζθνπό ηνπ. 

Γηα παξάδεηγκα ην <b>έληνλν θείκελν</b>  ππνδεηθλχεη φηη νη ζπζθεπέο πνπ ζα εκθαλίζνπλ ην 

θείκελν ζα ην θάλνπλ έληνλν, αιιά δελ ιέεη ηη ζα θάλνπλ κε ην θείκελν νη ζπζθεπέο πνπ δελ 

κπνξνχλ λα ην εκθαλίζνπλ, φπσο γηα παξάδεηγκα νη ζπζθεπέο θσλεηηθήο αλάγλσζεο ζειίδσλ. 

Σφζν ζηελ πεξίπησζε ηνπ <b>έληνλν</b>  φζν θαη ηνπ <i>πιάγην</i> , ππάξρνπλ άιια ζηνηρεία ηα 

νπνία κπνξεί λα νπηηθά λα εκθαλίδνληαη ίδηα, αιιά είλαη πην ζημανηικά, φπσο 

ηα <strong>ζεκαληηθφ θείκελν</strong> θαη <em>θείκελν κε έκθαζε</em>  αληίζηνηρα. Δίλαη 

επθνιφηεξα λα εξκελεχζεη έλαο θσλεηηθφο browser ηα ηειεπηαία δχν ζηνηρεία. Ωζηφζν, δελ 

είλαη ηζφηηκα κε ηα αληίζηνηρα ζηνηρεία νπηηθήο κνξθνπνίεζεο. Γηα παξάδεηγκα έλα πξφγξακκα 

θσλεηηθήο αλάγλσζεο ηεο ζειίδαο δελ ζα πξέπεη λα πξνθέξεη κε έκθαζε ηνλ ηίηιν ελφο βηβιίνπ, 

αιιά φηαλ ην ίδην πεξηερφκελν εκθαλίδεηαη ζε κηα νζφλε ηφηε ν ηίηινο ζα είλαη κε πιάγηα 

γξάκκαηα. Σα πεξηζζφηεξα ζηνηρεία νπηηθήο κνξθνπνίεζεο έρνπλ ζεσξνχληαη μεπεξαζκέλα κεηά 

ηελ πξνδηαγξαθή HTML 4.0, θαη έρνπλ αληηθαηαζηαζεί απφ ηα CSS. 

 

Η ζήκαλζε ππεξθεηκέλνπ θάλεη κεξηθά ηκήκαηα ελόο εγγξάθνπ λα ζπλδένπλ κε άιια 

έγγξαθα. 

Σα ζηνηρεία anchor δεκηνπξγεί έλαλ ππεξζχλδεζκν ζην έγγξαθν, θαη ε ηδηφηεηα href νξίδεη ηνλ 

ζηφρν ηνπ ζπλδέζκνπ. Γηα παξάδεηγκα, ε ζήκαλζε 

HTML <a href="http://el.wikipedia.org/">Βηθηπαίδεηα</a> εκθαλίζεη ην θείκελν «Wikipedia» σο 

ππεξζχλδεζκν. Γηα ηελ εκθάληζε κηαο εηθφλαο σο ζπλδέζκνπ, κπνξεί λα εηζαρζεί έλα ζηνηρείν 

«img» σο πεξηερφκελν ηνπ ζηνηρείνπ «a». πσο θαη ην «br», ην «img» είλαη άδεην ζηνηρείν. Έρεη 

ηδηφηεηεο αιιά δελ έρεη πεξηερφκελν, νχηε εηηθέηα ηεξκαηηζκνχ: <a 

href="http://example.org"><img src="image.gif" alt="descriptive text" width="50" height="50" 

border="0"></a>. 

 

3.9.3 Ιδηόηεηεο 

 
Οη πεξηζζφηεξεο ηδηφηεηεο ησλ ζηνηρείσλ είλαη δεχγε νλνκάησλ θαη ηηκψλ, ηα νπνία 

δηαρσξίδνληαη κε έλα «=» θαη γξάθνληαη κέζα ζηελ εηηθέηα εθθίλεζεο ελφο ζηνηρείνπ, κεηά ην 

φλνκα ηνπ ζηνηρείνπ. Η ηηκή κπνξεί λα πεξηθιείεηαη ζε κνλά ή δηπιά εηζαγσγηθά, παξφηη ηηκέο 

πνπ απνηεινχληαη απφ ζπγθεθξηκέλνπο ραξαθηήξεο κπνξνχλ λα γξάθνληαη ρσξίο εηζαγσγηθά 

ζηελ HTML, αιιά φρη ζηελ XHTML. Σν λα κέλνπλ νη ηηκέο ησλ ηδηνηήησλ ρσξίο εηζαγσγηθά 

ζεσξείηαη αλαζθαιέο. Δθηφο απφ ηηο ηδηφηεηεο πνπ γξάθνληαη σο δεχγε νλνκάησλ θαη ηηκψλ, 

ππάξρνπλ θαη κεξηθέο νη νπνίεο επεξεάδνπλ ην ζηνηρείν απιά κε ηελ παξνπζία ηνπο κέζα ζηελ 

εηηθέηα εθθίλεζεο, φπσο ε ηδηφηεηα ismap ηνπ ζηνηρείνπ img. 

 

Τπάξρνπλ θαη κεξηθέο θνηλέο ηδηφηεηεο νη νπνίεο εκθαλίδνληαη ζε πνιιά ζηνηρεία: 

 

 Η ηδηφηεηα id παξέρεη έλα αλαγλσξηζηηθφ γηα έλα ζηνηρείν ην νπνίν είλαη κνλαδηθφ ζε 

νιφθιεξν ην έγγξαθν. Υξεζηκνπνηείηαη γηα λα ηαπηνπνηεί ην ζηνηρείν ψζηε ηα CSS λα 

κπνξνχλ λα αιιάμνπλ ηνλ ηξφπν πνπ απηφ εκθαλίδεηαη, θαζψο θαη ηα ζελάξηα κπνξνχλ 

http://el.wikipedia.org/wiki/%CE%A5%CF%80%CE%B5%CF%81%CF%83%CF%8D%CE%BD%CE%B4%CE%B5%CF%83%CE%BC%CE%BF%CF%82
http://el.wikipedia.org/
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λα αιιάμνπλ, λα κεηαθηλήζνπλ ή λα δηαγξάςνπλ ηα πεξηερφκελα ή ηελ εκθάληζή ηνπ. 

Αθφκα, αλ έλα id πξνζηεζεί ζην URL κηαο ζειίδαο, παξέρεη έλα κνλαδηθφ 

αλαγλσξηζηηθφ γηα έλα ηκήκα ηεο ζειίδαο, γηα 

παξάδεηγκα:http://en.wikipedia.org/wiki/HTML#Attributes 

 Η ηδηφηεηα class παξέρεη ηε δπλαηφηεηα ηαμηλφκεζεο παξφκνησλ αληηθεηκέλσλ ζηελ ίδηα 

θιάζε. Μπνξεί λα ρξεζηκνπνηεζεί γηα λα λα απνδψζεη θάπνηα ζεκαζία ζην ζηνηρείν, ή 

γηα ζθνπνχο εκθάληζεο. Γηα παξάδεηγκα, έλα έγγξαθν HTML κπνξεί λα ρξεζηκνπνηεί 

ηελ επηζήκαλζε class="notation" ζε κεξηθά ζηνηρεία γηα λα μερσξίζεη απφ ην ππφινηπν 

θείκελν ηνπ εγγξάθνπ. Καηά ηελ εκθάληζε ηνπ εγγξάθνπ, απηά ηα ζηνηρεία κπνξεί -γηα 

παξάδεηγκα- λα εκθαλίδνληαη φια καδί ζην ηέινο ηεο ζειίδαο σο ππνζεκεηψζεηο, άζρεηα 

κε ηελ ζέζε πνπ εκθαλίδνληαη κέζα ζηνλ θψδηθα. Δπίζεο νη ηδηφηεηεο class 

ρξεζηκνπνηνχληαη ζεκαζηνινγηθά ζηα microformat. Έλα ζηνηρείν κπνξεί λα έρεη 

πνιιαπιέο θιάζεηο, γηα παξάδεηγκα ην class="notation important" βάδεη ην ζηνηρείν ηφζν 

ζηελ θιάζε «notation» φζν θαη ζηελ «important». 

 Η ηδηφηεηα style εθαξκφδεη ζηπι εκθάληζεο ζε ζπγθεθξηκέλα ζηνηρεία. Θεσξείηαη 

θαιχηεξε ηαθηηθή λα ρξεζηκνπνηνχληαη νη ηδηφηεηεο id ή class ψζηε λα επηιέγεηαη ην 

ζηνηρείν κέζα ζε έλα CSS, αιιά κεξηθέο θνξέο κπνξεί λα είλαη πην απιφ λα αλαηεζνχλ 

style θαηεπζείαλ ζην ζηνηρείν. 

 Η ηδηφηεηα title πξνζζέηεη κηα εμήγεζε ζην ζηνηρείν ζην νπνίν εθαξκφδεηαη. ηνπο 

πεξηζζφηεξνπο browser απηή ε ηδηφηεηα εκθαλίδεηαη σο αλαδπφκελν παξάζπξν βνήζεηαο. 

 Η ηδηφηεηα lang ηαπηνπνηεί ηελ θπζηθή γιψζζα ησλ πεξηερνκέλσλ ηνπ ζηνηρείνπ, ε 

νπνία κπνξεί λα είλαη δηαθνξεηηθή απφ ην ππφινηπν έγγξαθν. Γηα παξάδεηγκα, κέζα ζε 

έλα αγγιηθφ έγγξαθν κπνξεί λα ππάξρεη ην: 

<p>Oh well, <span lang="fr">c'est la vie</span>, as they say in France.</p> 

 

Σν ζηνηρείν abbr κπνξεί λα ρξεζηκνπνηεζεί γηα λα επηδείμεη κεξηθέο απφ ηηο πην πάλσ ηδηφηεηεο: 

<abbr id="anId" class="jargon" style="color:purple;" title="Hypertext Markup 

Language">HTML</abbr> 

 Απηφ ην παξάδεηγκα εκθαλίδεηαη σο: HTML. ηνπο πεξηζζφηεξνπο browser, φηαλ ζηαζεί ν 

δείθηεο ηνπ πνληηθηνχ πάλσ απφ απηφ ην ζηνηρείν, ηφηε ζα εκθαληζηεί έλα αλαδπφκελν παξάζπξν 

κε ην πεξηερφκελν «Hypertext Markup Language». 

 Σα πεξηζζφηεξα ζηνηρεία κπνξνχλ επίζεο λα δεθηνχλ ηελ ηδηφηεηα dir ε νπνία θαζνξίδεη 

ηελ θαηεχζπλζε ηνπ θεηκέλνπ. Η ηηκή «rtl» ηεο ηδηφηεηαο, δείρλεη θείκελν πνπ δηαβάδεηαη 

απφ δεμηά πξνο ηα αξηζηεξά, φπσο γηα παξάδεηγκα ζηα Αξαβηθά, ζηα Πεξζηθά ή ζηα 

Δβξατθά.  

 

3.9.4 Αλαθνξέο νληνηήησλ ραξαθηήξσλ 

 

Απφ ηελ έθδνζε 4.0 θαη κεηά, ζηελ HTML νξίδεηαη έλα ζχλνιν απφ 252 αλαθνξέο νληνηήησλ 

ραξαθηήξσλ θαη έλα ζχλνιν απφ 1.114.050 αλαθνξέο νληνηήησλ αξηζκψλ. Καη ηα δχν ζχλνια 

επηηξέπνπλ ηε γξαθή κνλαδηθψλ ραξαθηήξσλ σο ζήκαλζε, αληί ρξεζηκνπνηψληαο ηνπο ίδηνπο 

ηνπο ραξαθηήξεο. Έλαο ραξαθηήξαο θαη ε αληίζηνηρε ζήκαλζε γη' απηφλ ζεσξνχληαη ηζνδχλακεο 

νληφηεηεο, θαη εκθαλίδνληαη ίδηα. 

Απηή ε δπλαηφηεηα δηαθπγήο ραξαθηήξσλ κε απηφλ ηνλ ηξφπν επηηξέπεη ηελ εξκελεία 

ραξαθηήξσλ φπσο <  θαη &  (φηαλ γξάθνληαη σο &lt;  θαη &amp; , αληίζηνηρα) σο θείκελν θαη 

φρη σο ζήκαλζε. Γηα παξάδεηγκα, ν ραξαθηήξαο <  θαλνληθά ζεκαίλεη ηελ έλαξμε κηαο εηηθέηαο, 

θαη ην &  ζεκαίλεη ηελ έλαξμε κηαο αλαθνξάο νληφηεηαο ραξαθηήξα ή αξηζκνχ. Η γξαθή ηνπο 

http://el.wikipedia.org/w/index.php?title=Microformat&action=edit&redlink=1
http://el.wikipedia.org/wiki/%CE%91%CF%81%CE%B1%CE%B2%CE%B9%CE%BA%CE%AC
http://el.wikipedia.org/wiki/%CE%A0%CE%B5%CF%81%CF%83%CE%B9%CE%BA%CE%AC
http://el.wikipedia.org/wiki/%CE%95%CE%B2%CF%81%CE%B1%CF%8A%CE%BA%CE%AC
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σο &amp;  ή &#x26;  ή &#38;  επηηξέπεη ζην &  λα ζπκπεξηιακβάλεηαη κέηα ζην πεξηερφκελν 

ελφο ζηνηρείνπ ή κέζα ζηελ ηηκή κηαο ηδηφηεηαο. Δπίζεο, ν ραξαθηήξαο δηπιψλ εηζαγσγηθψλ ( " ), 

ν νπνίνο ρξεζηκνπνηείηαη γηα λα πεξηβάιεη ηελ ηηκή κηαο ηδηφηεηαο, πξέπεη λα γξάθεηαη 

σο &quot;  ή &#x22;  ή &#34;  φηαλ εκθαλίδεηαη κέζα ζηελ ίδηα ηελ ηηκή ηεο ηδηφηεηαο. Οκνίσο, 

ν ραξαθηήξαο κνλψλ εηζαγσγηθψλ ( ' ), πξέπεη λα γξάθεηαη σο &#x27;  ή &#39;  (αιιά φρη 

σο &apos;  εθηφο ζηελ XHTML) φηαλ εκθαλίδεηαη κέζα ζηελ ίδηα ηελ ηηκή ηεο ηδηφηεηαο. Αλ 

έλαο δεκηνπξγφο εγγξάθνπ HTML παξαβιέςεη λα γξάςεη απηά ηα ζχκβνια σο νληφηεηεο 

ραξαθηήξσλ ή αξηζκψλ, ηφηε κεξηθνί browser κπνξνχλ λα είλαη αξθεηά επηεθείο θαη πξνζπαζνχλ 

λα ρξεζηκνπνηήζνπλ ην παξαπιήζην πεξηερφκελν γηα λα καληέςνπλ ηελ πξφζεζε ηνπ ρξήζηε. Σν 

απνηέιεζκα δελ παχεη λα είλαη άθπξε ζήκαλζε, ε νπνία θάλεη ην έγγξαθν ιηγφηεξν πξνζηηφ ζε 

άιινπο browser νη νπνίνη κπνξεί λα πξνζπαζήζνπλ λα αλαιχζνπλ ην έγγξαθν γηα άιινπο 

ζθνπνχο, φπσο γηα παξάδεηγκα γηα ηελ θαηαρψξεζε ηνπ πεξηερνκέλνπ ηνπ ζε κεραλέο 

αλαδήηεζεο. 

Η δηαθπγή δηεπθνιχλεη επίζεο ηε ρξήζε ραξαθηήξσλ πνπ είηε είλαη δχζθνιν λα 

δαθηπινγξαθεζνχλ, είηε δελ ζπκπεξηιακβάλνληαη θαλ ζηελ θσδηθνπνίεζε ραξαθηήξσλ ηνπ 

εγγξάθνπ. Γηα παξάδεηγκα, ν ηνληζκέλνο ραξαθηήξαο e  (δειαδή ην é ), ν νπνίνο ηππηθά 

ζπλαληάηαη ζε κεξηθέο επξσπατθέο γιψζζεο, κπνξεί λα γξαθηεί ζε νπνηνδήπνηε έγγξαθν HTML 

σο ε νληφηεηα &eacute;  ή σο ε αξηζκεηηθή αλαθνξά &#233;  ή &#xE9; , ρξεζηκνπνηψληαο 

ραξαθηήξεο νη νπνίνη είλαη δηαζέζηκνη ζε φια ηα πιεθηξνιφγηα θαη ππνζηεξίδνληαη ζε φιεο ηηο 

θσδηθνπνηήζεηο ραξαθηήξσλ. Οη θσδηθνπνηήζεηο Unicode, φπσο ε UTF-8, είλαη ζπκβαηέο κε 

φινπο ηνπο ζχγρξνλνπο browser θαη επηηξέπνπλ ηελ πξφζβαζε ζε ζρεδφλ φινπο ηνπο ραξαθηήξεο 

φισλ ησλ ζπζηεκάησλ γξαθήο ηνπ θφζκνπ 

  

3.9.5 Σύπνη δεδνκέλσλ 

 

ηελ HTML νξίδνληαη κεξηθνί ηχπνη δεδνκέλσλ γηα ην πεξηερφκελν ησλ ζηνηρείσλ, φπσο 

ζελάξηα εληνιψλ ή stylesheet, θαη κηα πιεζψξα ηχπσλ γηα ηηο ηηκέο ησλ ηδηνηήησλ, 

ζπκπεξηιακβαλνκέλσλ ησλ ID, ησλ name, ησλ URI, δηαθφξσλ αξηζκψλ θαη κνλάδσλ κήθνπο, 

γισζζψλ, ηχπσλ αξρείσλ πνιπκέζσλ, ρξσκάησλ, θσδηθνπνηήζεσλ ραξαθηήξσλ, εκεξνκεληψλ 

θιπ. 

 

3.9.6  Μεηαθνξά ηεο HTML 

 
Σα αξρεία HTML, φπσο ζπκβαίλεη θαη κε ηνπο ππφινηπνπο ηχπνπο αξρείσλ ηνπ ππνινγηζηή, 

κπνξνχλ λα κεηαθεξζνχλ κε πνιινχο ηξφπνπο. Ωζηφζν, ιφγσ ηεο ιεηηνπξγίαο ηεο HTML, νη δχν 

πην ζπλεζηζκέλνη ηξφπνη είλαη κέζσ HTTP απφ έλαλ εμππεξεηεηή, ή κέζσ E-mail. 

 

HTTP 

 

O Παγθφζκηνο Ιζηφο απνηειείηαη θπξίσο απφ αξρεία HTML ηα νπνία κεηαθέξνληαη απφ 

εμππεξεηεηέο πξνο browsers ρξεζηκνπνηψληαο ην πξσηφθνιιν HTTP. Ωζηφζν, κηα πνπ ην ίδην 

πξσηφθνιιν κπνξεί επηπιένλ λα κεηαθέξεη εηθφλεο, ήρν θαη άιιν πεξηερφκελν, ρξεηάδεηαη έλαο 

ηξφπνο αλαγλψξηζεο ηνπ ηχπνπ ηνπ πεξηερνκέλνπ πνπ κεηαθέξεηαη. Έηζη, καδί κε ην ίδην ην 

αξρείν, κεηαθέξνληαη θαη κεξηθέο επηπιένλ πιεξνθνξίεο, ή κεηαδεδνκέλα, κεηαμχ απηψλ θαη ν 

http://el.wikipedia.org/wiki/Unicode
http://el.wikipedia.org/wiki/UTF-8
http://el.wikipedia.org/wiki/HTTP
http://el.wikipedia.org/wiki/%CE%95%CE%BE%CF%85%CF%80%CE%B7%CF%81%CE%B5%CF%84%CE%B7%CF%84%CE%AE%CF%82
http://el.wikipedia.org/wiki/E-mail
http://el.wikipedia.org/wiki/%CE%A0%CE%B1%CE%B3%CE%BA%CF%8C%CF%83%CE%BC%CE%B9%CE%BF%CF%82_%CE%99%CF%83%CF%84%CF%8C%CF%82
http://el.wikipedia.org/wiki/%CE%9C%CE%B5%CF%84%CE%B1%CE%B4%CE%B5%CE%B4%CE%BF%CE%BC%CE%AD%CE%BD%CE%B1
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ηχπνο ΜΙΜΔ (γηα παξάδεηγκα text/html ή application/xhtml+xml) θαζψο θαη ε θσδηθνπνίεζε 

ραξαθηήξσλ πνπ ρξεζηκνπνηείηαη. 

ηνπο ζχγρξνλνπο browser, ν ηχπνο MIME πνπ ζπλνδεχεη ην αξρείν HTML κπνξεί λα επεξεάδεη 

ηνλ ηξφπν πνπ απηφ εκθαλίδεηαη. Γηα παξάδεηγκα, έλα αξρείν ην νπνία ζπλνδεχεηαη απφ έλαλ 

ηχπν XHTML MIME, αλακέλεηαη λα είλαη γξακκέλν ζε γιψζζα ζσζηά δηαηππσκέλε, θαηά ηα 

πξφηππα ηεο XML. Αλ δελ είλαη, ηφηε ηα ζθάικαηα ζηνλ θψδηθα κπνξεί λα απνηξέςνπλ ηελ νξζή 

απεηθφληζε ηνπ αξρείνπ. Δπεηδή ε XHTML 1.0 θαη ε XHTML 1.1 είλαη πάληα ζπκβαηέο κε ηελ 

XML, ην W3C ππνζηεξίδεη φηη δελ παίδεη ξφιν πνηνο ηχπνο MIME ζα ρξεζηκνπνηεζεί 
 
HTML e-mail 

 

Αξθεηά πξνγξάκκαηα ειεθηξνληθήο αιιεινγξαθίαο ελζσκαηψλνπλ δπλαηφηεηεο ηεο HTML, 

ψζηε λα επηηξέπνπλ ζηνπο ρξήζηεο λα ρξεζηκνπνηνχλ ηελ ζήκαλζε ηεο HTML ζηα κελχκαηά 

ηνπο, γηα λα ζηέιλνπλ θείκελν κε ρξψκα, κε κνξθνπνίζεο, ή θαη κε ελζσκαησκέλεο εηθφλεο θαη 

δηαγξάκκαηα. Ωζηφζν, ε κέζνδνη απηέο πξνθαινχλ κεξηθά πξνβιήκαηα, ηα νπνία πξνθαινχληαη 

αθ' ελφο απφ ηελ έιιεηςε θάπνηνπ πξνηχπνπ γηα ηελ πεξίιεςε HTML ζε E-mail (κε απνηέιεζκα 

ν θάζε πξνγξακκαηηζηήο λα ελεξγεί θαηά βνχιεζε), θαη αθ' εηέξνπ απφ ηε δπλαηφηεηα 

εθκεηάιιεπζεο απηψλ ησλ δπλαηνηήησλ απφ θαθφβνπινπο ρξήζηεο. 

 

Ολφκαηα αξρείσλ 

 
Ο πην θνηλφο ηχπνο αξρείν γηα έγγξαθα HTML είλαη .html, φκσο έρεη επηβηψζεη θαη ε 

ζπληφκεπζε .htm, απφ κεξηθά παιαηφηεξα ιεηηνπξγηθά ζπζηήκαηα πνπ δελ αλαγλψξηδαλ επεθηάζεηο 

αξρείσλ κε πεξηζζφηεξα απφ ηξία γξάκκαηα. Δπηπιένλ, ζηα Microsoft Windows ρξεζηκνπνηείηαη ν 

ηχπνο .hta (απφ ην HTML Application) ν νπνίνο δείρλεη φηη ην αξρείν ζπκπεξηιακβάλεη HTML καδί 

κε θάπνηα δπλακηθά ζηνηρεία πνπ ην θάλνπλ λα εθηειείηαη σο εθαξκνγή. 

 

http://el.wikipedia.org/wiki/HTML 

Κεθάιαην 4: Αλάιπζε ιεηηνπξγίαο joomla 

 

Όπωσ αναφζραμε ςτην ενότητα 3.8  «Το joomla  είναι μία πλατφόρμα –ελεφθερη προσ χρήςη- 

ανοιχτοφ κώδικα για ηλεκτρονικό εμπόριο.».....«Το joomla εχει πληθώρα επιλογών και 

χαρακτηριςτικών που μποροφν να βοηθήςουν ςτην παραμετροποίηςη του ηλεκτρονικοφ 

καταςτήματοσ.». Τισ επιλογζσ που μασ παρζχει και τα διάφορα χαρακτηριςτικά του θα δοφμε 

και θα αναλφςουμε ςε αυτό το κεφάλαιο με την βοήθεια και εικόνων αποτφπωςησ τησ οθόνησ 

του υπολογιςτή (screenshots). 

 

http://el.wikipedia.org/w/index.php?title=%CE%9C%CE%99%CE%9C%CE%95&action=edit&redlink=1
http://el.wikipedia.org/wiki/XML
http://el.wikipedia.org/wiki/Microsoft_Windows
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4.1 Δίζνδνο δηαρεηξηζηή 

 

 

16 admin login 

 

ηελ νζφλε απηή ν δηαρεηξηζηήο θαιείηαη λα δψζεη ην φλνκά ηνπ (username) θαζψο θαη ηνλ 

θσδηθφ πξφζβαζήο ηνπ (password), πνπ έρεη νξίζεη απφ ηελ αξρή ηεο δεκηνπξγίαο ηνπ 

ειεθηξνληθνχ θαηαζηήκαηνο. ε πεξίπησζε πνπ ν δηαρεηξηζηήο έρεη μεράζεη ηνλ θσδηθφ 

πξφζβαζεο, επηιέγνληαο ην ―forgotten password‖ πιαηθφξκα ηνλ παξαπέκπεη ζε κία άιιε ζειίδα 

ζηελ νπνία θαιείηαη λα ζπκπιεξψζεη ην e-mail ηνπ γηα λα ηνπ ζηαιεί εθεί ν θσδηθφο ηνπ. 
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4.2 Κεληξηθό κελνύ 

 

17  opencart home menu 

Μεηά ηελ είζνδν ηνπ ν δηαρεηξηζηήο βξίθεηαη ζηελ αξρηθή ζειίδα ηνπ opencart. ε απηή βιέπεη 

ζην πάλσ κέξνο ηηο εμήο επηινγέο: System (θέληξν ειέγρνπ), users (ρξεζηεο), menu (κελνπ), 

content (πεξηερνκελν), compoment, extention , help (βνήζεηα). ην κελνπ content πξνζζεηνπκε 

πεξηερσκελν, ηννπνην ζην joomla ιεγεηαη article, θαη κε ηε βνεζεηα ηνπ menu, νδεγνπκε απην ην 

πεξηερνκελν ζην site καο. ην κελνπ extention κπνξνπκε λα πξνζζεηνπκε δηθα καο template, 

modules, compoment, plug in θαη λα ηα δηαρεηξηδνκαζηε αλαινγσο. 

ε απηε ηε πηπρηαθε ρξεζηκνπνηεζεθαλ ηα εμεο extentions:  

 hikashop (εηλαη ην compoment γηα ην ειεθηξνληθν θαηαζηεκα) 

 JSN ImageShow (εηλαη ην compoment γηα ην θεληξηθν slideshow) 

 Form maker (εηλαη ην compoment γηα ηε θνξκα επηθνηλσληαο) 

 JSN Force FREE (εηλαη ην θεληξηθν template) 
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4.3 Γεκηνπξγεηα Article 

 

4.3.1 Add new article 

Παηακε ην add new article θαη βιεπνπκε ηνλ editor νπνπ κπνξνπκε λα γξςαςνπκε κε δηαθνξα 

θνξκαη θεηκελν, λα πξνζζεζνπκε εηθνλεο, ιηλθ θηι. 

 



Πτυχιακή εργαςία τμήματοσ Μηχανικϊν Πληροφορικήσ 

 

 

46 

 

 

 

4.3.2 How to link articles in the Joomla 3 menu 

 

Once you have created your article you will most probably want to link it in the menu of your 

website, so that your visitors can actually be able to find and see it. To do this you need to use the 

Main menu manager.

 

 

After you have indicated that you want to create a new menu item, you will have to select the 

type of the menu item: 
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Since we will be linking content created through the Article manager we should click on the 

Articles link 

in the list. If you want the new menu to simply open the article you have just created simply press 

the Single Article option. 

 

 

Once you choose this option, a box for selecting which article exactly you wish to link to will 

appear: 

 

That's it, you can now open your website and see your newly created menu item that links to your 

new Joomla article. 
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4.3.3 How to manage Article categories 

 

Categories for articles are created in order to allow you to group your content better. If you have 

different types of pages on your site, or you write on different topics, you should add article 

Categories to group your content. Article categories can be managed through the Content 

manager. To add a new category go to Content -> Category Manager -> Add New Category. 

 

Categories don't have a lot of properties. If you plan to have many categories, you can write a 

brief description of each one of them in order to avoid mistakes when you add articles to them. 

However, adding description is not mandatory, so you can simply add Title for your category and 

press the green Save button. 
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That's it. Now, when you add new articles to your website, you can choose them to belong to the 

newly created category 

 

 

4.3.4 How to manage Component categories 

Many Joomla 3 components utilize the use of categories. For example, you can organize the feeds 

you display on your website in different categories. They work exactly the same as the ones for 

your articles, but they are located in the individual component's menu. 

 

 

The only difference between article and component categories is that when you choose the 

categories menu for the particular component, you're redirected directly to the categories manager 

for that component. Here, you need to press the green New button in order to add a category. 
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This page is exactly the same as the one used for article categories - add Category Title, 

Description(optional), and hit the save button. 

 

 

That's it, you can now use the newly created category to group your component items. 

 

 

 

4.3.5 Listing Categories on a Joomla 3 page 

 

If you want to list your categories on your website, you need to use the Joomla Menu 

functionality. First, add a new item to the menu, as we previously did in our tutorial on linking 

articles in the Joomla menu with one minor difference - this time, you need to choose a different 

menu type. But first things, first. Go to Menus -> Main Menu(or other menu in your site) -> Add 

New Menu Item. 
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Here, click on the Select button next to the Menu Item Type label to choose what kind of menu 

you want to add. 

 

 

For the purpose of this tutorial, we will add a menu item, that will display all the categories of 

articles we have previously added. To do so, expand the Articles section and press List All 

Categories. 
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Finally, choose the title for your menu item and the Top level category you want to display. If 

you want to show all categories, select "Root". If you want to display only sub-categories of a 

particular category, you need to set it as a top level category. Finally, press the Save button in the 

top left part of the screen. 

 

That's it, once you click on the newly created menu item Categories Menu, you will see a list of 

all the article categories. Next to each category, you will see a number showing how many 

articles belong to that category. 
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4.3.6 Mark Joomla 3 articles Featured 

 

First, you need to mark some articles in your site as Featured. To do this go to Content -> Articles 

Manager. Here, you will see a list of your articles. Note that there is a star next to each article. To 

mark an article as Featured, simply press the star next to it. It will turn yellow, indicating that 

you've marked this article as featured. 

 

 

4.3.7. Show Featured articles on a page linked in the Joomla menu 
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If you want to manually choose the articles displayed on a page, the Featured Articles menu type 

in Joomla 3 is exactly what you need. 

First, let's create a new menu item. To do this go to Menus -> Main Menu(default main menu) -> 

Add New Menu Item (you can do the same with existing menu items, for example the Home 

menu). 

 

 

Next, we should select the menu type by pressing the Select button next to the Menu Item Type 

label. 

 

 

 

A popup with the available menu types will appear. Expand the Articles section and select the 

Featured Articles option. 
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Finally, press the Save button in the top left corner of this page. 
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4.3.8 Upload the Template via the Extension Manager 

Once you have your Joomla template downloaded on your computer, login to the administrative 

area of your Joomla website and upload the template through the Extension Manager (Extensions 

-> Extension Manager). The process is the same for templates, modules, plugins and components. 

 

Once the template is installed in your Joomla 3 application, you need to make it default for your 

website so your pages get the new design. First, you need to go to Extensions -> Template 

Manager. 
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On this page, you will see a list of the installed templates available for your site and the 

administrative area. Locate the one you want to use on your site and click on the star icon next to 

it. 

 

4.3.9 Access the Joomla Extension Manager 

 

The first thing you need to do is to login to the administrative area of your Joomla website. Once 

you do that, access the Joomla Extension Manager by going to Extensions -> Extension Manager. 

 

 

Once you open the Extension Manager, you have three options to chose from to install your 

extension. In most cases, you should go for the first option but it's good to know that there are 

alternatives. 
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This is one of the most convenient options available. All you need to do is hit the Browse button, 

browse to the location of your extension's archive on your local computer, and press the Upload 

& Install button. 

 

 

This option is suitable for large extensions, that exceed in size the server PHP Upload Filesize 

limitation and cannot be uploaded through the previous method. Such components, modules or 

plugins must be uploaded via FTP to a folder in your hosting account since FTP can transfer 

much bigger files. For more information on how to use FTP to upload your extension check out 

our FTP Tutorial. 

 

IMPORTANT! 

It is important to know that unlike the first method, you need to extract your extension first and 

upload the folder and not the zip archive. 

Once you have uploaded the extension directory to your hosting account, go to the Extensions 

Manager and specify the path to that folder. Finally, press the Install button. Joomla 3 will check 

the folder you've specified and install the extension if it is uploaded correctly. 
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The third available option for Joomla extensions installation is directly though an URL. All you 

need to do is to enter the direct address of the zip archive with the extension you want to install 

and press the Install button. Joomla 3 will download, extract and make the necessary installations 

for you. 

 

 

 

4.3.10 Content created with Components manager 

 

By default, the Components manager includes several options for adding more complex page 

types and other content to your Joomla website. Joomla 3 comes with a few preinstalled 

components that allow you to create special page types: Contacts, Newsfeeds, Search, Smart 

Search and Web links. 

 

 

If you want to create a page with news feed for example, you need to go to Components -> 

Newsfeeds -> Feeds and than click the big green NEW button. 
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To link content created with the Components manager in your website menu, you need to go to 

the Menu manager: 

 

 

Once you click on Create New Menu Item you need to select the type of the Item you will add: 
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Find the corresponding line for the component you have used, for example if you are trying to 

create a Newsfeeds page, click the Newsfeeds link from the list. 
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Now, you need to select the exact Feed the menu should link to. To do that click on the Select 

button next to the Feed field and choose the newly created Test feed. Finally, press the Save 

button to publish this menu item on your website. 

 

 

 

4.4  Create a Contact item using the Joomla 3 Contacts component 

First, you need to create the actual content of your Contact Us page. To do this, login your 

administrative area and go to Components -> Contacts. On this page hit the green New button to 

create a new contacts page. 

 
Here you need to specify a unique name for that contact. For the purpose of this tutorial, we will 

make only one Contact Us page. We will not dig further into the different Contact us categories, 

since they basically use the same logic as Joomla articles. This is why we can safely leave the 
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new contact page uncategorized. Finally, click on the Contact Details tab to proceed with the 

page creation. 

 
Now you need to enter your contact information. Make sure you enter a valid e-mail address, 

because it will be used by the contact form. Once you fill in all the information you want to share 

with your visitors, click on the Save button in the top left part of the page. 

 
Now, we need to enable this contact form. To do this, simply hit the red icon next to the Contact 

Form element in order to change its status from unpublished to published. The icon should turn 

green and you can proceed with the next step of this tutorial. 
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We're almost done with the creation of the contact page. The last thing we need to do is to add a 

Contact Us link to the menu of our site. In our case, we will add it to the main menu. To do this 

go to Menus -> Main Menu -> Add Menu Item. 

 
On this page there are few things you need to configure. First, click on the Select button next to 

the Menu Item Type field. 

 

 

A lightbox will appear asking you to chose the type of menu item you will be creating. Select 

Contacts -> Single Contact. 
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Now you need to specify the exact Contact item you want to display in that menu. To do this, hit 

the Select button next to the Select Contact field. 
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Once you do that, choose the form we've created through the default Joomla 3 contact component 

(should be only one contact form that you can click on). 
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Once you do that, select a title for that menu item. This is the actual text that will be shown on 

your site menu. Once you fill in that information, click on the Save button in the upper part of the 

page. 
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4.4.1 How to Add Banners to Joomla 3 Sites 

 
By default Joomla 3 comes with a component for managing banners. It allows you to add 

different banners, organise them into categories and display them in different places on your 

website. The first thing you need to do is to create a new banner. To do this login to your Joomla 

admin area and go to Components -> Banners -> Banners. 

 

On this page, click on the green New button at the top left part of the page. 
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Now, you need to fill in some information for the banner you're adding and its code. First, choose 

a name for the banner. Name your banners with unique, meaningful names so you can easily 

organise them later. Next, select Custom from the Type drop-down. This will allow you to paste 

the banner code you've obtained from the site you're advertising. Finally, paste the banner code 

into the Custom Code field and press the Save & Close button. 

 

Now you need to publish a new module to display your newly embedded banner. To do this go to 

Extensions -> Module Manager. 

 

Once more, press the green New button in order to add a new module to your site. 
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Joomla 3 will provide you with a list of the available module types that you can choose from. 

Simply click on the banners type. 

 

On this page, you need to choose a title for the module and the position where it will be 

displayed. Note that the available positions and their names depend on the template you're 

currently using. Different templates have different places where you can add modules (in our case 

- banners). For the purpose of this tutorial, we will add our banner in the right column of the 

default Joomla 3 template (position-7). Once you chose title and position for the module, press 

the Save button at the top left part of the page. 



Πτυχιακή εργαςία τμήματοσ Μηχανικϊν Πληροφορικήσ 

 

 

71 

 

 

 

4.4.2 Form Maker Lite (extention) 

Απν ην extention manager πξνζζεηνπκε ην compoment πνπ θαηεβαζακε απν ην ηληεξλεη θαη ην 

πξνζζεζακε. Δπηηα πακε ζην κελνπ compoment θαη ην επηιεγνπκε: 



Πτυχιακή εργαςία τμήματοσ Μηχανικϊν Πληροφορικήσ 

 

 

72 

 

 

 

Αθνπ ην επηιεμνπκε παξαηεξνπκε νηη ερνπκε θαπνηεο εηνηκεο θνξκεο λα ρξεζηκνπνηεζνπκε, ε 

κπνξνπκε παησληαο ην θνπκπη newλα δεκηνπξγεζνπκε κηα δηθε καο. 
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4.4.3 Template (extention) 

Αθνπ εγθαηαζηεζνπκε ην template απν ην extention manager, επηιεγνπκε απν ην κελνπ ην 

extention θαη κεηα tamplate, νπνπ επηιεγνπκε απην πνπ εγθαηαζηεζακε: 
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Βιεπνπκε νηη ππαξρνπλ θαπνηεο ξπζκηζεηο γηα ην ζπγθεθξηκελν template, νπσο γηα ην 

logo, ην layout ή ην menu. Με απηα κπνξνπκε λα ξπζκηζνπκε ηηο default ξπζκληζεηο. 
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4.4.4 JSN ImageShow (extention) 

Αθνπ εγθαηαζηεζνπκε ην compoment γηα ην θεληξηθν slide απν ην extention manager, πακε ζην 

κελνπ θαη ην επηιεγνπκε 

 
Παξαηεξνπκε νηη ερνπκε δηαθνξεο επηινγεο, ηνζν γηα ην πνηεζ εηθνλεο λα δεηρλεη ην slide, νζν 

θαη γηα ην πνηα κνξθη ζα ερνπλ. Γηα λα ηα ξπζκηζνπκε απηα, παηακε αλαινγσο, ηνλ πξαζηλν 

ζηαπξν δηπια απν απην πνπ ζεινπκε λα δεκηνπξγεζνπκε: 
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4.4.5 HikaShop (extention) 

Σν πνην ζεκαληηθν θαη ην νπνην βαζηδεηε απηε ε πηπρηαθε, εηλαη ην extention hikaShop. Σν 

HikaShop παξερεη ελα θαηλνπξην control panel κεζα ζην joomla νπνπ κεζα ζε απην κπνξνπκε λα 

δηαρεηξηζηνπκε πξνηνληα, θαηεγνξηεο, καξθεο, πσιεζεηο, παξαγγειεηεο, ζηαηηζηηθα, θαη γεληθα 

νηη ρξεηαδεηαη ν admin γηα λα δηαρεηξηζηεη ελα eshop. Αθνπ ην θαηεβαζνπκεην εγθαηαζηνπκε 

απν ην extention manager θαη πακε ζην κελνπ compoment θαη ην επηιεγνπκε. 
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Δδσ βιεπνπκε ηηο πνιιεο δπλαηνηεηεο πνπ καο παξερεη ην control panel ηνπ hikashop. Δρεη ελα 

κελνπ, νπνπ επηιεγνληαο ην products κπνξνπκε λα πξνζζεζνπκε πξνηνληα, θαηεγνξηεο 

πξνηνλησλ, καξθεο θηι. Δπηιεγνληαο απν ην κελνπ ην Customers κπνξνπκε λα δνπκε δηαθνξα 

ζηνηρεηα πειαησλ. Δπηιεγνληαο ην orders κπνξνπκε λα δνπκε ηηο παξαγγειεηεο. 

 

Γεληθα εηλαη ελα επρξεζην control panel πνπ παξερεη ηε δπλαηνηεηα ζηνλ admin λα δηαρεηξηζηεη 

ελα eshop. 
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4.4.5.1 HikaShop System menu - Configuration 

 

 

 

Παησληαο ηελ επηινγε confiquration, κπνξνπκε λα ξπζκηζνπκε ην layout ησλ πξνηνλησλ, ηνπο 

θνξνπο, ηεο παξαγγειεηεο, ηηο εηθνλεο, ην λνκηζκα, θαη γεληθα νηη ππαξρεη θαη ερεη λα θαλεη κε ην 

πξνηνλ πνπ βιεπεη ν πειαηεο ζην site καο. 
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4.4.5.2 HikaShop System menu - Zones 

Με ηελ επηινγε Zones, δηαιεγνπκε γενγξαθηθε δσλη πνπ βξηζθεηε ην εεθηξνληθν καο 

θαηαζηεκα. 
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4.4.5.3 HikaShop System menu - Payment methods 

Με ηελ επηινγε payment, κπνξνπκε δηαιεμνπκε ην ηξνπν πνπ ζα γηλνληαη νη πιεξσκεο, πρ κεζσ 

paypal ή visa θηι. 
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4.4.5.4 HikaShop System menu - Shiping methods 

Με ηελ επηινγε Shiping methods ξπζκηδνπκε ηα εμνδα απνζηνιεο αλαινγα κε ηε ρσξα πνπ 

ζεινπκε λα ηα ζηεηινπκε. 
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4.4.5.5 HikaShop System menu - Plugins 

Με ηελ επηινγε Plugins καο δηλεηαη ε δπλαηνηεηα λα πξνζζεζνπκε ηα δηθα καο plugins εηζη σζηε 

λα δηαρεηξηδνκαζηε ην hikashop. 
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4.4.5.6 HikaShop System menu - Warehouse 
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4.4.5.7 HikaShop System menu - Taxes 

Με ηελ επηινγε Taxes κπνξνπκε λα ξπζκηζνπκε ηνπο θνξνπο πνπ αλαινγνπλ αλαινγα ηε ρσξα 

πνπ βξηζθνκαζηε. 
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4.4.5.8 HikaShop System menu - Currencies 

Απν εδσ κπνξνπκε λα επηιεμνπκε ην λνκηζκα πνπ ζαερεηηνeshop καο, πρ EUR, USD θηι. 
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4.4.5.9 HikaShop System menu - Order statuses 
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4.4.5.10 HikaShop System menu - Mass actions 
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4.4.5.11 HikaShop Product menu - Add a product 

Σν κελνπ add product, εηλαη ην ζεκαληηθνηεξν πνπ ρξεζηκνπνηεη θαπνηνζ ζην hikashop. Απν εδσ 

πξνζζεηεηο ηα πξνηνληα, εηθνλεο πξνηνλησλ, καξθεο, θσδηθνπο πξνηνλησλ, ηηκε, εμνδα 

απνζηνιεο θηι. Μηα ζεκαληηθε επηινγε εδσ εηλαη νηη κπνξεηο λα δηαιεμεηο θαηεγνξηα πξνηνληνο 

(ηελ νπνηα ερνπκε δεκηνπξγεζεη, νπσο ζα δνπκε πην θαησ), θαη ζα κπνξνπκε λα ηελ 

εκθαληδνπκε ζην site καο. 

 

 

 

 

4.4.5.12 HikaShop Product menu - Products 

Με ηελ επηινγε productsκαο εκθαληδεηε κηα ιηζηα κε νια ηα πξνηνληα πνπ ερνπκε πξνζζεζεη ζην 

eshop καο. 
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4.4.5.13 HikaShop Product menu - Categories 

Μηα ζεκαληηθε δπλαηνηεηα πνπ παξερεη ην hikashop εηλαη ε θαηεγνξηνπνηεζε ησλ πξνηνλησλ. 

απην βνεζαεη κεηα ζηελ εκθαληζε ηνπο ζην site καο.  
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4.4.5.14 HikaShop Product menu - Charasteristics 

Δπηιεγνληαο ην charasteristics, κπνξνπκε λα θηηαμνπκε ηα ραξαθηεξηζηηθα ηνπ πξνηνληνο καο, 

νπσο απηα ζα θαηλνληαη ζην ρξεζηε, πρ ηηκε, θσδηθν, εμνδα απνζηνιεο θηι. 



Πτυχιακή εργαςία τμήματοσ Μηχανικϊν Πληροφορικήσ 

 

 

96 

 

 

 

 

 

 

 

4.4.5.15 HikaShop Product menu - Brands 

Με απηε ηελ επηινγε κπνξνπκε λα δεκηνπξγηζνπκε ηηο καξθεο ησλ πξνηνλησλ καο πνπ ερνπκε 

ζην θαηαζηεκα καο. 
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4.4.5.16 HikaShop Product menu - Badges 

Με απηε ηελ επηινγε κπνξνπκελα ξπζκηζνπκε ηακπειαθη αλαγλσξηζεο ηνπ πξνηνληνο καο. πρ ζε 

πνζεο πνζνηεηεο ην ερνπκε, ηελ πνηνηεηα, κεθνο πιαηνο πξνηνληνο θηι. 
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4.4.5.17 HikaShop Product menu - Import 
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Με απηε ηελ επηινγε κπνξνπκε λα δηαιεμνπκε ην ηξνπν εηζαγσγεο ησλ πξνηνλησλ καο, αλ εηλαη 

γηα παξαδεηγκα απν θαθειν, απν αιιν cms (opencart, virtuemart) θηι. 
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Κεθάιαην 5: Δπίινγνο 

 
Παξαπάλσ είδακε ινπφλ ηελ αικαηψδε αλάπηπμε ηνπ ειεθηξνληθνχ εκπνξίνπ θαη  

δεκηνπξγήζακε έλα ειεθηξνληθφ θαηάζηεκα κε ηε ρξήζε ηνπ Hikashop. Δίδακε πην αλαιπηηθά 

γηα ην CMS Joomla θαη γηα ην Component Hikashop. Φηηάμακε έλα site, δεκηνπξγήζακε έλα 

κελνχ, εηζάγακε πξντφληα θαη ηα βάιακε ζε θαηεγνξίεο. Δίδακε πσο κπνξεί έλα ρξήζηεο λα 

θάλεη εγξαθή ζην e-shop, πσο κπνξεί λα ηα βάιεη ζην θαιάζη ηνπ, ηνλ ηξφπν πιεξσκήο ησλ 

πξντφλησλ, πσο κπνξνχκε λα βάινπκε ηηκή ζε έλα πξντφλ θαη ηελ πεξηγξαθή ηνπ.  

 

 

Epiloque 
Abone we saw the rapid development of the e-commerce and the creation of an online store. We 

saw more details about the CMS Joomla and Hikashop Component. We made a site, we created a 

menu, we introduced products and we put them into categories. We saw how a user can make 

registration to the e-shop, how he can put products in the basket,  payment methods and how we 

can set a price to the produst and a description. This was an easy method to create an online store 

to sell our products. Ideal for sites with low to medium traffic. 

 

 

 


